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1. GSGT Overview 

The Graphic Simulation Generation Tool (GSGT) generates scenarios based on National Air Space (NAS) 
adaptation for simulation of traffic to various Air Traffic Control (ATC) systems.  These scenarios can be 
used as a source of real time inputs to facilitate testing and integration of NAS ATC systems and related 
subsystems.  GSGT employs a Graphical User Interface (GUI) to aid in scenario development and is 
capable of automatically generating flight data messages. 
 
GSGT has the capability of creating scenarios for dynamic injection.  When launched in dynamic 
simulation mode, GSGT generates the initial flight plans and departure messages.  All other flight data 
messages are generated when the scenario is executed. 
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2. Getting Started 

The processor with GSGT installed is configured to boot up to a user login screen.  Users can enter a 
username and password, then click the “Login” button or press Enter on the keyboard. 
 

 

Figure 1. GSGT Processor Login 

 
NOTE: The ‘root’ user does not have access to the GSGT commands and utilities.  If root access is needed 

while logged in, the user should either log out and log in again as ‘root’ or open a terminal 
window, type su and enter the ‘root’ user password. 

 
After a short loading period the KDE desktop will appear. 
 

 

Figure 2. GSGT Processor Desktop  
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3. System Configuration 

3.1. Environment Variables 

GSGT uses environment variables for the locations of source and exported scenario files, weather 
scenarios, and adaptation data, including En Route Automation Modernization (ERAM), Standard 
Terminal Automation Replacement System (STARS), and Time Based Flow Management (TBFM) 
adaptation files. 
 

Table 1. Environment Variables 

Variable Name Description Default Location 

GSGT_WORK_PATH Location of source scenario files. /usr/local/gsgt 

SDRR_SCENARIO_PATH Location of exported SDRR scenario files. /usr/local/scenarios 

WX_PATH Location of weather scenarios. /opt/wx 

ADAPTATION_PATH Location of adaptation data. /opt/adaptation 

 

3.2. Starting GSGT 

To start GSGT from the command line, enter: 

> gsgt 

 
To launch a GSGT version that is not the default version, enter: 

> /usr/local/jvn.x.x.x/bin/gsgt 

 
NOTE: Starting GSGT from a command line while inside the scenario directory will automatically open 

that scenario. 
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3.2.1. Version Warning 

When a scenario that was previously saved with a different version of GSGT is opened, GSGT will display 
a warning. The warning shows the current version of the scenario and the version of GSGT that is actively 
running. If “Continue” is selected, the scenario will be converted to the new version and saved in the 
new format. If “Cancel” is selected, the scenario will not be opened. 
 

 

Figure 3. Version Warning 

 

3.2.2. Command Line Options 

GSGT can be started with various options which control its operation. 

Table 2. Program Parameters 

Parameter Description 

--dysimMode 
DYSIM mode for dynamic scenario execution with the 
ERAM system. 

--eramSimMode or  
--terminalMode 

ERAM simulation mode or Terminal mode for dynamic 
scenario execution without an ERAM system. 

--proxy=server/port Opens GSGT with specific server/port for mapTiles. 

--open Opens the GSGT Open Scenario window. 

--new Opens the GSGT New Scenario window. 

--version Display GSGT version. 

--nofullscreen 
Not full screen mode; GSGT will be stared in a window 
roughly half the size of the screen. 

--help Display application parameters. 
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For example, GSGT can be started in ERAM Simulation Mode: 

> gsgt --eramSimMode 

 

3.2.3. GSGT Modes 

GSGT operates in several modes that are tailored to specific functionality. 
 

Table 3. GSGT Operation Modes 

Mode Description 

Normal Mode 
Normal mode is tailored for creating target scenarios to be exported to SDRR for 
execution with the ERAM system. 

DYSIM Mode 
DYSIM mode is tailored for creating target scenarios for dynamic execution using 
the ERAM system. 

Terminal/ERAM 
Simulation Mode 

Terminal or ERAM simulation mode is tailored for creating target scenarios for 
dynamic execution without an ERAM system. 
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3.3. Graphical User Interface 

The GSGT Graphical User Interface (GUI) includes a menu bar, a toolbar, and a large map display. 
 
 

 

Figure 4. GSGT GUI 

 

3.3.1. Menu Bar 

A menu bar is displayed along the top, just below the title of the main GSGT GUI. 
 

 

Figure 5. Menu Bar 
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The menu bar includes the following options: 
 
Scenario 

Provides options to create a New scenario, Open an existing scenario, Edit the current scenario, Save 

the current scenario, Save As the current scenario with a different name, or Exit the GSGT GUI. 

Import 

The Import menu provides options to import scenario elements from another GSGT scenario, 

NASQuest, a CSV file, or STARS CDR. 

Reports 

The Reports menu provides options to generate various reports for the currently open scenario such 

as: GSGT Session Log, Simulated Target Position, FAV Traversal Report, and Simulated Radar Target 

Count. 

Help 

The Help menu provides options to select About (F1) and Scenario Info (F2).  About displays the 

About GSGT dialog, and Scenario Info displays the Scenario Information dialog. 

 

 

Figure 6. About GSGT 
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Figure 7. Scenario Information 

 

3.3.2. Toolbar 

The scenario toolbar includes icons to create a New scenario, Open an existing scenario, Edit the current 
scenario, Scenario Manager (in Normal, Terminal, and TGF Modes; Scenario Manager is not available in 
DYSIM Mode), Save the current scenario, and Save As to select a different name. 
 

 

Figure 8. Toolbar 

 
By clicking and dragging the toolbar handle (which looks like a double separator), the toolbar can be 
docked to either the top, bottom, left, or right of the main GSGT window or it can be left to float above 
the map display.  The toolbar can be displayed or hidden by right-clicking anywhere on the main menu 
bar and selecting Toolbar. 
 

 

Figure 9. Toolbar Display Control  
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3.3.3. Map Display 

GSGT provides a graphical representation of various adaptation elements on the Map Display.  The Map 
Display also has its own menus, tools, and a status bar (when invoked). 
 

 

Figure 10. Map Display Menus and Tools 

 
The Map Display menus are: 
 
View 

The View menu is used to select adaptation elements for background display.  These elements may 

be displayed individually or in combinations. 

 
NOTE: Each menu and submenu has a dashed line at the top.  Selecting the dashed line will “tear off” the 

menu into a new dialog.  The menu will remain displayed after a selection is made. 
 

 

Figure 11. Menu Tear-off 
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Adaptation elements available for display are: 
 

Maps 

Political maps displaying boundaries in blue are available, and include US Map showing state 

boundaries, Canada showing provinces and territories, and Mexico. 

 

 

Figure 12. Map Selection 

 
 

Background maps are available if an internet connection is established and include Virtual Earth, 

Open Street Map, Google Satellite, Google Street, Google Terrain, Stamen, and ThunderForest.  

STARS maps are also available if using a STARS adaptation and running in Terminal Mode.  Select 

the site to display STARS maps.  In the figure below, maps for STARS site ‘phl’ are available.  The 

default is No Background Map. 
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Figure 13. Background Maps 

 
Customized map overlays can also be added to Maps. This can include simple lines or complex 

shapes. The example below shows a map overlay for a Special Activities Airspace (SAA).  To 

generate this figure, the map coordinates need to be added to custom-map.xml file as shown 

below. The style of the line and the color can be adjusted. For GSGT to add the map option, it 

must be included in the gsgt.cfg file as shown below. 

 
Example custom-map.xml file: 

<map> 

  <linesegment color="white" style="DashLine"> 

    <vertex pos="+28:40:00.00,-080:41:00.00"/> 

    <vertex pos="+29:52:00.00,-079:21:00.00"/> 

    <vertex pos="+29:47:00.00,-079:15:00.00"/> 

    <vertex pos="+28:28:00.00,-080:34:00.00"/> 

    <vertex pos="+28:40:00.00,-080:41:00.00"/> 

  </linesegment> 

</map> 
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Example gsgt.cfg file: 

<config> 

  <display height="3000." name="ZBW" projection="stereographic" r0="3438.520" 

scale="0.40" tangent="+43:48:34.00,-072:26:24.00" width="3600."> 

    <map color="0,0,255" file="maps/us.dat" name="US Map" type="noaamap" 

visible="1"/> 

    <map color="0,0,255" file="maps/canada.shp" name="Canada" type="shpfile" 

visible="1"/> 

    <map color="0,0,255" file="maps/mexico.shp" name="Mexico" type="shpfile" 

visible="1"/> 

    <map color="200,100,0" file="./custom-map.xml" name="SAA" type="xmlfile" 

visible="1"/> 

  </display> 

</config> 

 
 

 

Figure 14. Customized “SAA” map overlay added to Maps 
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Airspace 

Contains submenus with options to display national En Route data, including: 

 

 

Figure 15. Airspace Options 

 
 

Fixes 

Contains a submenu with the following: 

VORs (white and purple dots)  

VOR Labels (purple letters)  

DMEs (white and olive dots)  

DMEs Labels (olive letters)  

TACANs (white and olive dots)  

TACANs Labels (olive letters)  

NDBs (white and blue dots)  

NDB Labels (blue letters)  

Waypoints (white and turquoise dots)  

Waypoint Labels (turquoise letters)  

Fix Aliases (white and turquoise dots)  

Fix Alias Labels (gray letters)  
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Airports 

Contains a submenu with the following: 

Airports (green and white triangles)  

Airport Labels (green letters)  

Airport Aliases (green and white triangles)  

Airport Alias Labels (green letters)  

 
Airways 

Contains a submenu with the following: 

High Airways (tan lines and turquoise points)  

Low Airways (tan lines and turquoise points)  

Other Airways (tan lines and turquoise points)  

 
DPs 

Departure Procedure (turquoise lines and points) 

STARs 

Standard Terminal Arrival Route (turquoise lines and points) 

Coded Routes 

adapted routes (heavy tan lines and turquoise points) 

ADRs 

Adapted Departure Routes (teal lines, gray points, and turquoise points and airports) 

AARs 

Adapted Arrival Routes (teal lines, gray points, and turquoise points and airports) 

ADARs 

Adapted Departure/Arrival Routes (teal lines, gray points, and turquoise points and airports) 

DLines 

lines in the airspace if crossed, the flight is forced onto a ADR (green lines and gray points) 

ALines 

lines in the airspace if crossed, the flight is forced onto a AAR (green lines and gray points) 
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ARTCC Name 

Each En Route center adaptation included in the scenario has its own submenu with options to 

display local adaptation data. 

 

 

Figure 16. ARTCC Options 

 
FAVs 

Fixed Airspace Volumes (gray for ARTCC and orange for Terminal airspace) 

Boundary 

Area of responsibility (AOR) boundary (red line) 

ARTCC Boundaries 

Boundaries of all ARTCCs (dark red) 

FP AOI 

Flight Plan (FP) Area of Interest (AOI) boundary (green) 

Service Volume AOI 

ADS-B Service Volume Area of Interest boundary (blue) 
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Surv AOI 

Surveillance Area of Interest boundary (teal) 

APD Boundary 

(yellow) 

Surv Sort Cells 

Radar Surveillance Sort Cell Grid (green) 

TAVs 

Terrain Alert Volumes (yellow cross-hatching with red outline) 

SAAs 

Special Activities Airspace (solid orange lines, with dotted-line buffer area) 

AAVs 

Aircraft Alert Volumes (purple) 

Clutter Zone Filters 

(gray) 

Geomaps 

Contains a submenu with the names of the adapted Geomaps (white) 

Sectors 

Contains a submenu with the adapted sector plans (green) 

 
External Facilities 

When checked, this option displays adapted non-US airspace shaded in purple. 

Radars 

The Radar submenu lists all adapted radar sites and an option for toggling all radar sites on or 

off.  When a radar site is on, the range is displayed as a circle with a shaded area indicating the 

coverage area at the selected altitude. 
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Figure 17. Radar Options 

 
ASDEX 

The ASDEX submenu provides an option for toggling ASDEX on or off.  When ASDEX is on, the 

range is displayed as a shaded circle. 

 

 

Figure 18. ASDEX Options  
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WAM 

The WAM submenu provides an option for toggling WAM on or off.  When WAM is on, the range 

is displayed as a shaded circle. 

 

 

Figure 19. WAM Options 

 
ADS-B Service Volumes 

The ADS-B Service Volumes submenu lists all adapted service volumes and an option for toggling 

all service volumes on or off.  When a service volume is on, the range is displayed as a shaded 

circle. 

 

 

Figure 20. ADS-B Options 
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WX hh:mm:ss 

If the target scenario includes a weather scenario, a WX submenu is available for each weather 

forecast hour and displays Temperature (various colors), Pressure (gray contour lines), Wind, 

(white arrow vectors) and Precipitation (various colors). 

 

 

Figure 21. Weather Options 
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Terminal Airspace Adaptation 

Terminal Airspace Adaptation contains a submenu listing all user defined macros and an option 

for toggling the display of all macros on or off.  Terminal Airspace Adaptation also contains: 

 

 

Figure 22. Site Definition Data 

 
Macros 

User defined route macros. 

Points 

(yellow dots) 

Airports 

(purple triangles) 

 
Find 

The Find menu can be used to search the adaptation for airspace elements by name.  When found, 

the element(s) are added to the map display and a context box is displayed with details about the 

element. 
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Figure 23. Find Menu 

 
Settings 

Clicking on Settings displays the following submenus: 

 

 

Figure 24. Settings Options 

 
Save Display Settings 

Allows saving of preferred display settings. 

 
Load Display Settings 

Allows loading of previously saved display settings. 

 
Flight Level 

The Flight Level tool allows an altitude to be set either by typing the value into the box or by clicking 

the up and down arrows.  Changing the altitude also changes the sector and facility boundaries that 

are displayed. 

 

 

Figure 25. Flight Level 
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Zoom 

The Zoom tool allows the range of the display to be adjusted using a wheel selector. 

 

 

Figure 26. Zoom 

 
Range 

The Range tool displays the horizontal size (in nmi) of the airspace showing in the map display. 

 

 

Figure 27. Range 

 

3.3.4. Status Bar 

The Status Bar, also referred to as the Measurement Bar, located on the bottom of the main window is 
used to display measurement information from the map.  The bar is automatically displayed and updated 
upon user action that triggers the measurement information. 
 
To display lat/lon and X/Y system coordinates at any specific point, hold down the SHIFT key while mouse 
clicking in any particular location on the map.  Holding down the SHIFT key and left-click dragging the 
mouse will display spherical distance in nmi, heading, both true and magnetic, and delta X/Y system 
coordinates. 
 

 

Figure 28. Status Bar 
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3.3.5. Context Boxes 

Shift+right clicking on any airspace item (such as a Fix, Airport, or FAV) will cause the item to be 
highlighted and a context box to be displayed.  A context box displays information about the airspace 
item.  The contents of each context box depend on the type of item selected and may contain a menu 
that includes additional data for the selected item. 
 
Right clicking on an item, without holding down the Shift key, will highlight the item and display the item 
name directly on the screen. 
 
A context box can be closed by right clicking again on the item, or by selecting the ‘X’ button on the 
window. 
 
 

 

Figure 29. Context Boxes 
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4. GSGT Scenarios 

4.1. Creating a New Scenario 

Creating a new scenario generates a blank scenario with no targets, commands or any definitions.  A 
New Scenario Wizard is used to guide the user through selections to create a new scenario by selecting 
a scenario name, adaptation, and optional weather scenario. 
 
To create a new scenario, select Scenario->New from the GSGT Main Window. 
 
NOTE: If a scenario is already open when the Scenario->New option is selected, the new scenario will be 

automatically configured to use the same adaptation(s) as the current scenario. If you wish to 
select the adaptation(s), exit and re-start GSGT without opening another scenario, then select 
Scenario->New. 

 
Back 

Goes to the previous screen. 

Next 

Goes to the next screen. 

Cancel 

Quits the scenario wizard without creating a new scenario. 

 

4.1.1. Adaptation Selection 

NAS adaptation data should exist in subdirectories named eadp (or ERAM), for ERAM adaptation, STARS, 
and TBFM under the in ADAPTATION_PATH directory.  The first screen of the New Adaptation Wizard 
will display a list of these subdirectories.  Expanding the eadp (or ERAM) subdirectory will result in the 
Loading window to be displayed while information about the ERAM adaptation is parsed.  Once parsing 
of the adaption data is completed, the list of available adaptations are displayed. 
 
NOTE: This step is skipped if another scenario was open before Scenario->New was selected. 
 
While loading adaptation list a dialog is displayed until all adaptation data information is collected. 
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Figure 30. Loading Adaptation List 

 

4.1.1.1. Single Adaptation 

At least one ERAM adaptation must be selected.  The adaptation is then parsed to create the airspace 
adaptation objects as well as the facility adaptation information. 
 

 

Figure 31. Selecting an ERAM Adaptation 
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4.1.1.2. Multiple Adaptations 

Multiple ERAM adaptations may be selected. The first adaptation selected (marked with a diamond in 
front of its name) is parsed to create the airspace adaptation objects (which define the entire airspace).  
All selected adaptations are parsed for their facility adaptation information.  To select additional 
adaptations hold down the CTRL key while clicking on individual adaptation names, or hold SHIFT key 
while clicking on the additional adaptation to select a range (all adaptations will be selected between 
the first and last adaptation selection). 
 

 

Figure 32. Selecting Mulitple ERAM Adaptations 

 
  



 
 
 

 
Volume 2: GSGT User Guide  March 8, 2024 
Version 13.4.19  Page 37 

4.1.1.3. Adding Child Adaptation or Customization File 

To add child adaptation (Terminal, TBFM, etc…) or TBFM Customization, right click on the ERAM 
adaptation and select one of the available pop up menu options.  A file manager window is displayed 
allowing the user to navigate to the adaptation or customization file.  Once the desired child adaptation 
is selected, click on Choose.  The child will appear under the selected ERAM adaptation.  This can be 
done for multiple adaptations, as well. 
 

4.1.1.3.1. Adding STARS DMS Report File 

Right click on the ERAM adaptation and select ‘Add STARS DMS file’.  A file manager window is displayed 
allowing the user to navigate to the STARS DMS report file. 
 

 

Figure 33. Adding STARS DMS File 
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Figure 34. Selecting the DMS File Location 

 
 

 

Figure 35. Selecting the TRACON Folder  
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Figure 36. Selecting a DMS Report File 

 
 

 

Figure 37. STARS DMS Report File Added  
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4.1.1.3.2. Adding STARS Site File or User Defined Macros 

Right click on the ERAM adaptation and select ‘Add STARS ATCoach site file’.  A file manager window is 
displayed allowing the user to navigate to an ATCoach site file or a custom user created macro definitions 
file.  Custom macros can be created for special routes and procedures that can be applied to target 
dynamics within GSGT. 
 
 

 

Figure 38. Adding STARS Adaptation 
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Figure 39. Selecting the STARS Adaptation Location 

 
 

 

Figure 40. Selecting the TRACON Folder  
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Figure 41. Selecting a Site File 

 
 

 

Figure 42. STARS Adaptation Added  
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4.1.1.3.3. Adding TBFM Adaptation 

Right click on the ERAM adaptation and select ‘Add TBFM adaptation’.  A file manager window is 
displayed allowing the user to navigate to the TBFM adaptation. 
 
 

 

Figure 43. Adding TBFM Adaptation 
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Figure 44. Selecting TBFM Location 

 

 

Figure 45. Selecting TBFM Adaptation  
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Figure 46. TBFM Adaptation Added 
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4.1.1.3.4. Adding TBFM Customization File 

Right click on the ERAM adaptation and select ‘Add TBFM customization file’.  A file manager window is 
displayed allowing the user to navigate to the TBFM customization file.  The TBFM customization file is 
required for TTP airport definitions for TFDM simulation. 
 
 

 

Figure 47. Adding a TBFM Customization File 
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Figure 48. Selecting TBFM Customization File Location 

 
 

 

Figure 49. Selecting TBFM Customization File 
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Figure 50. TBFM Customization File Added 
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4.1.1.4. Removing Child Adaptation 

To remove a child adaptation, right click on the child adaptation and select ‘Remove’. 
 
 

 

Figure 51. Removing a Child Adaptation 
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4.1.1.5. ERAM Adaptation File Overrides 

Occasionally, there may be a need to override a particular ERAM adaptation file with an informal version.  
For example, a user may want to modify the restrictions on an arrival route or the attributes of a radar 
site.  GSGT allows a modified file to be specified to replace the file delivered in the local adaptation. 
 
Once the GSGT scenario is saved, the scenario directory is created and a scenario.xml file is written.  That 
scenario.xml file can be edited to add the override sub-element to the eadp stanza where the ERAM 
adaptation is specified.  The value of the override sub-element is the modified informal adaptation file.  
The override sub-element has one attribute, product, which specifies the delivered file that is to be 
replaced. 
 
In the example below, the delivered files STAR.xml.75 and Radar.xml.68, located in the 
ERAM/ZNY_f20e3no0 adaptation directory, will be replaced by the modified files STAR.xml and 
Radar.xml, located inside the GSGT scenario directory. 
 

<scenario version="13.3.2"> 

  <airspace> 

    <eadp dir="ERAM/ZNY_f20e3no0"> 

      <override product="STAR.xml.75">./STAR.xml</override> 

      <override product="Radar.xml.68">./Radar.xml</override> 

      <dms file="STARS/phl/phl_s6r8a01_y7_08a_Y708A.bl_j3011092022.rpt" name="PPP"/> 

      <tbfm dir="TBFM/ZNY_T4.8.3_2.0"/> 

    </eadp> 

  </airspace> 

... 

 



 
 
 

 
Volume 2: GSGT User Guide  March 8, 2024 
Version 13.4.19  Page 51 

4.1.2. Scenario Location and Name 

 

Figure 52. Selecting a Scenario Location and Name 

 
Location Selector 

Location of the scenarios, such as default local directory GSGT_WORK_PATH or other media such as 

CD-ROM or flash drive. 

Scenario Name 

Scenario name can be an existing scenario name or a new scenario name typed in by the user.  The 

new scenario will be created in the selected directory.  Selecting an existing scenario will populate 

the name for the new scenario, and if user proceeds with creation of new scenario the existing 

scenario will be overwritten. 
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NOTE: Directories are displayed in blue and scenarios are displayed in green.  Read-only directories and 
scenarios are colored black and gray respectively.  Right-click on a directory allows the user to 
create a new directory or subdirectory under the selected directory. 

 

4.1.3. Weather Selection 

Weather files may be selected by clicking or highlighting the desired weather directory.  Selecting a 
weather file is optional. 
 

 

Figure 53. Selecting a Weather Scenario 

 
Finish 

Parses the adaptation data and loads the scenario.  Not enabled until an adaptation is selected. 
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Cancel 

Cancels creation of the new scenario. 

 

4.1.4. Scenario Overwrite Warning 

The warning is displayed to alert the user that a scenario file exists with the same name. 
 

 

Figure 54. Scenario Overwrite Warning 

 
Yes 

Overwrites the existing scenario with the current scenario. 

No 

Cancels the save scenario operation. 

 

4.2. Open an Existing Scenario 

To open an existing scenario, select Scenario->Open from the GSGT Main Window. 
 
NOTE: Starting GSGT Editor from a command line while inside the scenario directory will automatically 

open that scenario. 
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Figure 55. Opening an Existing Scenario 

 
Back 

Disabled in this window. 

Finish 

The selected scenario is opened in the GSGT main window. Enabled after a scenario is selected. 

Cancel 

Closes the window and cancels scenario open action. 

 
NOTE: Opening a scenario which uses different adaptation than the current scenario will close the current 

GSGT session and start a new one.  It may take a few seconds for the new GSGT session to appear 
(depending on system performance). 
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4.2.1. Load Progression Display 

The window below will be displayed and the step currently being performed will be listed at the bottom 
of the window.  When completed, an adaptation window will be displayed and the scenario can be 
reviewed or modified. 
 

 

Figure 56. Load Progression 

 

4.2.2. Scenario File Loading Errors 

If there are errors encountered while loading the scenario, the GSGT Session Log will be displayed listing 
all errors encountered during loading. 
 

 

Figure 57. Loading Errors 
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4.3. Edit Scenario 

The main scenario editor window displays a list of objects by type that can be edited.  Clicking on an 
object type displays all of the instances of the object type contained in the scenario, if any. 
 

Select Scenario->Edit or use the edit icon    from the GSGT Main Window. 
 

 

Figure 58. Scenario Editor 

 
Clicking the ‘Name’ button will toggle between sorting the object instances in ascending and descending 
order.  The triangle in the ‘Name’ button indicates which ordering will be used after the button is clicked. 
The same applies for the other buttons. 
 
Scenario Editor also provides the ability to view adapted equipment as defined by selected adaptation(s), 
such as Sensors and ADS-B Service Volumes. 
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4.3.1. Create a New Object 

To create a new object, right-click on the object listing or white space if there are no objects created.  A 
context menu with the option 'New' is displayed.  Selecting 'New' from the menu opens a dialog window 
to define the new object. 
 

 

Figure 59. Creating a New Object 

 

4.3.2. Delete Object 

To delete an object, right-click on an object instance name.  A context menu with 'Delete' (and possibly 
other options) is displayed.  Selecting 'Delete' from the menu opens a confirmation dialog, asking user 
to confirm deletion of the selected object(s). 
 

 

Figure 60. Object Delete Confirmation  
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4.3.3. Edit Object 

To edit an object, double-click on an instance name and the editor window will be replaced with the 
editor dialog for specific type of object instance selected.  The example below is a Target editor window. 
 

 

Figure 61. Object Editor 
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4.3.4. Replicate Object 

Replication provides the ability to produce copies of the selected objects such as System Commands or 
Targets. The replications can be dynamic (not frozen), so that single object manages all its replications 
and a change to that object is reflected across all replications of that object. For dynamically replicated 
targets, all messages and events associated with the original target, will also be generated for each target 
replication.  Alternatively, replications can be frozen, which creates a copy of the original object; 
therefore, the new objects can be independently modified to specific needs. 
 
The Replication Editor dialog varies depending on whether a System Command or Target is being 
replicated. As shown in the figure below, the following options are available for Target replications. 
System Command replication options only allow the user to specify the number of replications and a 
delta time between replications. 
 

 

Figure 62. Replication Editor 

 
Replications 

The number of replicated objects. 

Delta Acid 

Delta in Acid between replications. If the base target has the identifier UAL101, and '1' is specified 

for the Delta Acid, the following Acids are achieved in replications: UAL102, UAL103, UAL104… 

Delta Tail Num 

Delta in Tail Number between replications. If the base target has the Tail Number N12345, and '2' is 
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specified for the Delta Tail Num, the following Tail Numbers are achieved in replications: N12347, 

N12349, N12351... 

Delta ICAO Address 

Delta in ICAO Address between replications. If the base target has an ICAO Address of AB00E9, and 

'3' is selected for the Delta ICAO Address, the following ICAO codes are achieved in replications: 

AB00EC, AB00EF, AB00F2... 

Delta Beacon 

Delta in Beacon code between replications. If the base target has a beacon code of 1011, and '3' is 

selected for the Delta Beacon, the following beacon codes are achieved in replications: 1014, 1017, 

1022... 

Delta Time 

Delta in time between replications. The default time is 20 minutes. If the original object has a scenario 

time of 00:10:00 then the first replication will enter the scenario at 00:30:00. 

Freeze Replications 

When checked, produces hard copy replications that are no longer tied to the original object. Frozen 

replications will appear separately in the GSGT Editor list view. Non-frozen replications remain 

associated with the original. 

OK 

Adds the specified number of replications to the scenario. 

Cancel 

Closes the 'Replicate' window without saving changes. 

 
Leaving the pointer over a non-frozen replicated System Command or Target will cause a balloon help 
to appear with the details of the replication. 
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Figure 63. Replications 
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4.4. Save Scenario 

To save current scenario select Scenario->Save from the GSGT Main Window. 
 
To save a scenario under a different name select Scenario->Save As from the GSGT Main Window.  This 
allows the user to specify the name and location of the scenario files.  A directory with the name as the 
specified in Scenario Name is created in the selected location. 
 

 

Figure 64. Save Scenario 

 

4.4.1. Scenario Overwrite Warning 

When a scenario name is specified in the Save Scenario dialog already exists, the user is prompted to 
overwrite the existing scenario. 
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Figure 65. Scenario Overwrite Warning 

 
Yes 

The existing scenario file is overwritten. 

No 

The save action is cancelled. 

 

4.4.2. Save Scenario Before Exit 

When the user attempts to exit the GSGT application and unsaved changes have been made to the 
scenario, the following dialog is displayed. 
 

 

Figure 66. Save Before Exit 

 
Yes 

The scenario file is saved and the application is exited. 

No 

The scenario file is NOT saved and the application is exited. 
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5. Scenario Editor 

The Scenario Editor window is comprised of multiple tabs, including Preferences, Sensors, RSIs, 
Adaptation, System Commands, Targets, and Script Definitions.  Note that not all tabs are available in all 
GSGT modes.  The Sensors and Adaptation tabs display adapted surveillance items and interfacility and 
display system items, respectively, for reference only.  The remaining tabs contain lists of scenario 
objects by type that can be edited. 
 

 

Figure 67. Terminal and ERAM Sim Mode Tabs 

 

 

Figure 68. Normal and Dysim Modes Tabs 

 

5.1. Preferences 

Preferences are used to specify timing and other attributes of the scenario.  The attributes specified in 
the Preferences tab are applied to the scenario globally.  Some timing parameters can be applied to 
individual targets through the Target editor; see section 5.6.1.3.2 for more details.  GSGT looks for a 
preferences configuration file called prefs.xml.  If prefs.xml cannot be found, standard defaults values 
are used. 
 

5.1.1. Edit Preferences 

To edit Scenario Preferences, click on the Preferences tab in the Scenario Editor Main Window. 
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Figure 69. Preferences Tabs 

 
Export Msg Timing Parameters 

System Setup Time 

No messages will be injected before this time, unless the message is marked as a system setup 

message.  This allows messages such as combine sector and switch activity to be injected prior 

to any flight data messages. 

Tgt Min Intermsg Time 

The minimum amount of time between auto-generated messages for the same target.  This 

ensures that messages associated with the same target will not be injected out of order.  It is 

useful in large scenarios, when message injection times tend to be delayed due to equipment 

injection delays. 
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Msg Auto-Derive Parameters 

FP Lead Time 

For auto-generated messages, the amount of time preceding a target start time or preceding a 

boundary crossing that the fight plan messages will be scheduled for injection.  For a departure 

flight, the initial proposed flight plan will be generated with an injection time that is FP Lead Time 

prior to the departure time.  For an active flight, the flight plan will be generated with an injection 

time that is FP Lead Time prior to the start of the radar track.  If a flight crosses any enroute or 

terminal facility boundaries, the flight plan generated for each downstream facility will have an 

injection time that is FP Lead Time prior to the boundary crossing time. 

Track Start Offset 

For auto-generated messages, the time after a target start time for a flight that starts inside an 

adapted local facility that the start track message (QT) will be scheduled for injection. 

Intra-facility Lead Time 

For auto-generated messages, the time before an inter-sector boundary crossing when the 

initiate handoff message (QN) will be scheduled for injection. 

Inter-facility Lead Time 

For auto-generated messages, the time before an enroute or terminal facility boundary crossing 

when the initiate handoff message (TI) will be scheduled for injection. 

Handoff Accept Delta 

For auto-generated messages, the time between the initiate handoff message and the accept 

handoff message for both intra-facility and inter-facility transfers of control. 

Use FPL with NADIN source 

By default, domestic proposed flights are auto-generated with FP messages.  With this option 

selected, all domestic proposed flights are generated using FPL messages injected from the 

specified NADIN source. 

Apply 

Save and apply the changes made and close the Preferences editor dialog. 
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5.2. Sensors 

GSGT uses surveillance devices defined in adaptation.  Surveillance equipment attributes can be viewed 
but not modified.  To expand the subtree contained in particular type of equipment click on the triangle 
icon to the left of the item. 
 

 

Figure 70. Sensors Tab 
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5.3. RSIs 

Record Selection Indicators, abbreviated RSI, can be used to identify various messages, which can then 
be selected or filtered during runtime. 
 

5.3.1. Create and Edit RSI 

To create a new RSI, click on the RSIs object label in the Scenario Editor Main Window and right-click the 
object list.  Select New from the context menu. 
 

 

Figure 71. RSI Editor 

 
 
Value 

Any string can be used for the RSI value. 

 
NOTE: Each string value can only be used for one RSI.  A dialog box stating “RSI exists” will appear if the 

string entered is already being used for another RSI once OK is selected. 
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Figure 72. RSI Exists Warning 

 
Description 

Text description of the RSI. 

OK 

Save and apply the changes made and close the RSI editor dialog. 

Cancel 

Cancel the changes made and close the RSI editor dialog. 

 

5.3.2. Edit Objects Associated with Specific RSI 

From the Scenario Editor, left-click on Filters, then select Filter by RSI to display the list of RSI(s) to filter 
the editor by. 
 

 

Figure 73. Filtering the Editor 
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Figure 74. RSI Filter Selection 

 
This filters the scenario editor by the RSI(s) selected. 
 

 

Figure 75. Objects Filtered by RSI 

 

5.4. Adaptation Equipment and DS 

GSGT uses equipment devices based on the positions and devices defined in adaptation.  Equipment 
attributes can be viewed but not modified.  To expand the subtree contained in a particular type of 
equipment click on the triangle icon to the left of the item. 
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5.5. System Commands 

Messages defined in the system commands tab are not associated with any Target and can be injected 
from any supported device.  These might be system setup type messages such as combine sector or 
switch activity.  Any message can be scripted, including flight data.  The editor supports freehand text 
editing of messages that allows users to create any valid or invalid message format.  Note that flight data 
messages would have to be scripted without any substitution tokens that reference a particular target, 
such as AID, CID, GUFI, etc.  If target token substitution is needed, the flight data message must be 
scripted within the Target editor; see section 5.6.1.3.5. 
 

5.5.1. Create and Edit System Command 

Certain system commands require or may be formatted with special characters or values that are 
represented as tokens.  These tokens can be entered into the text of a System Command to be 
substituted to corresponding hex code or values during the scenario export.  The primary reason for 
these tokens is to provide an ASCII character representation for non-printable character values or for 
values that are unknown until the export or run time. 
 

Table 4. Special Character Tokens 

Token Description 

\d downward-pointing arrow aka arrival arrow 

\u upward-pointing arrow aka departure arrow 

\c or | clear weather symbol 

\o or ' overcast weather symbol 

\xHH arbitrary value, where HH is a two digit hex value 

\p interfacility messages parity error 

\e EOM token 

\l LRC error 

 
 
NOTE: Not all tokens may be appropriate in all message types. 
 
NOTE: Tokens are not case sensitive, so for instance ether \c or \C can be used. 
 
NOTE: Entering an extra slash before a character will 'escape' it and not generate a special character. For 

example, the string "\\c" will be exported as "\c" and not as a clear weather symbol. 
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5.5.1.1. Message Editor 

To create a new System Command, select a message type and appropriate device(s) from the drop 
downs above the text input area.  Enter a message injection time offset and select an RSI, if desired.  
Type the message contents into the free form text area and press enter or right-click and select Save.  
The new message is added to the message list below the text input area.  Some message types will only 
accept specific formats; for example rtcsmsg will only accept a message in xml format. 
 

 

Figure 76. Message Editor 

 
Time 

Input box allowing entry of the time the message is to be injected into the scenario. 

RSI 

Drop down list of RSIs allowing selection of the desired RSI. 
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Type 

Drop down menu allowing selection of the type message to be injected.  Depending on the type of 

message, additional fields will appear for message sources and input devices. 

 

Table 5. Message Types with Facility and Device Fields 

Message Type Facility/Device Field 1 Facility/Device Field 2 

ifmsg Source Destination 

ssrvmsg ERAM Device 

fdiomsg ERAM Device 

nadinmsg Source Address Destination Address 

icaoMsg Source Fac Dest Fac 

wmscrmsg Dest ERAM N/A 

tdlsEramMsg TDLS N/A 

tdlsTfdmMsg TDLS N/A 

swimmsg Dest ERAM TMI 

cmsmsg ERAM N/A 

aigMsg STARS N/A 

tfmsMsg N/A N/A 

cpdlcmsg N/A N/A 

afnmsg N/A N/A 

rtcsMsg Airport N/A 

ttpMsg Airport N/A 

tcwMsg Facility Position 

 
 
Text 

Message text.  Freeform text area. 
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5.5.1.1.1. TCW Messages 

To create a scripted TCW message, click the Type drop down box and select tcwMsg. Two new options 
will appear, FAC and Position. Select the appropriate FAC and use the drop down to select a Position. 
The Position is set to an asterix (*) symbol as default when generating a configuration file with a report 
file adaptation. Use the message text box area to enter a scripted TCW message with the available 
tokens for key substitution.  
 
NOTE: To use scripted TCW messages, the Position needs to match the configuration file position name. 
 

 

 

Figure 77. TCW Message 
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NOTE: Dwelling the cursor in the message text area when the message type tcwMsg is selected will 
display the following list of tokens available for key substitution: 

 

 

Figure 78. TCW Message Tokens 
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5.6. Targets 

A Target is a representation of a flight with certain characteristics such as aircraft dynamics, equipment, 
route of flight, and events that control almost every aspect of its identity. The targets also include a set 
of messages, identical in structure to System Commands, but are associated with that particular target. 
The messages can be automatically derived based on the characteristics of the target, manually entered 
or be a combination of both. 
 
 

 

Figure 79. Targets Tab 

 

5.6.1. Create and Edit Target 

To create a Target, right-click on the Targets object label in the object list of the Scenario Editor Main 
Window.  Select New from the context menu. 
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5.6.1.1. Target - Main 

The general target attributes are located on the Main tab of the Target editor.  The attributes describe 
the target's characteristics such as on-board navigation equipment and transponder types. 
 

 

Figure 80. Target Editor Main Tab 

 
 
Name 

Two to seven alphanumeric characters designating the identity of the flight.  The first character must 
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be alphabetic, and may be followed by any combination of 1-6 alphanumeric characters. The 

minimum length is two (one letter and one digit). The minimum length for a letter-only name is three. 

Starttime 

The time at which the target becomes active.  The time is specified in days, hours, minutes, and 

seconds. 

Equipment 

Transponder 

ATCRBS 

Mode 3A and Mode C 

Mode 3A only 

 
Mode S 

Mode3A and ModeC 

UAT 

ADSB only 

1090ES 

Mode3A, ModeC, and ADSB 

CPDLC 

Datacomm Clearance Type 

PDC 

DCL 

Beacon code 

One to four octal digits designating the beacon code for the aircraft. Values less than four digits 

will be left-padded with zeroes to reach a length of four. Supplying a beacon code is optional; 

GSGT will generate beacon codes for aircraft as needed. 

ICAO Address 

Six hex digits designating the ICAO address for the aircraft. Supplying an ICAO address is optional; 

GSGT will generate ICAO address for aircraft as needed. 

NAS Equipment 

The single-letter equipment id. It is appended to aircraft type in the FP message. 
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RSI 

List of RSI descriptions for this target. Clicking 'Select' will open a scroll down menu allowing you to 

select the desired RSI. 

Registration 

Tail Number 

Two to seven alphanumeric characters designating the aircraft's tail number. The first character 

must be alphabetic and may be followed by any combination of 1-6 alphanumeric characters. 

The minimum length is two (one letter and one digit). 

Script definitions 

If a Target has a script defined it will run the script at the time set by the user. The start of the script 

can be relative to the target start (activation) time or it can be triggered by a particular generated 

message. The script can be a set of common messages that can be applied to multiple targets without 

having to script each set individually for each target.  This is primarily used for DataComm and TFDM 

Terminal Publication (TTP) message sets. 

Comments 

Any comments associated with the target. Comments are not displayed during scenario playback. 

ICAO Data Overrides 

ICAO Data overrides used for generating flight plan messages. New elements can be added by right 

mouse click, selecting New Element and entering the element key name. New Values can be added 

to an element by double clicking the Value field for the element. After creating at least one element 

right clicking again will give the option to Delete the highlighted element. 

 

Some ICAO data is automatically generated in the flight plan message based on other inputs, such as 

registration and navigation and surveillance equipage. Entries in the ICAO Data Overrides will 

override the automatically generated values. Neither the element key nor the value is validated for 

correctness. It is up to the scenario developer to script the appropriate overrides. However, only 

valid keys will be incorporated into the generated flight plan message. 

 

The user can dwell the cursor over the ICAO Data Overrides input area to see a tool tip listing the 

valid key names. Each key also lists the ICAO field that will be updated in a FPL message and the CMS 

field that will be updated in a FH message. 
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Figure 81. ICAO Data Override Keys 

 
NOTE: There are certain interdependencies between ICAO Data fields.  For example, to make a flight 

eligible for an RNAV route, EQP must include the letter ‘R’ and PBN must include an ‘A’, ‘B’, ‘C’, or 
‘D’.  For RNP flights, EQP must include the letter ‘R’ and PBN must include an ‘L’, ‘O’, ‘S’, or ‘T’.  
Also, NAV should include the RNV and/or RNP accuracy for the applicable phase of flight. 

 
CMS Overrides 

CMS overrides used for generating FH messages in eramSimMode. New elements can be added by 

right mouse click, selecting New Element and entering the element key name. New Values can be 

added to an element by double clicking the Value field for the element. After creating at least one 

element right clicking again will give the option to Delete the highlighted element. 

 

Some CMS data is automatically generated in the FH message based on other inputs, such as 

registration and navigation and surveillance equipage as well as the ICAO Data Overrides. (For 

example, the RNAV accuracy specified in the ICAO Data NAV field is used to automatically generate 

the CMS field 925 elements.) Entries in the CMS Overrides will override the automatically generated 
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values. Neither the element key nor the value is validated for correctness. It is up to the scenario 

developer to script the appropriate overrides. However, only valid keys will be incorporated into the 

generated messages. 

Show FH 

The Show FH button opens a pop up window that shows what the current generated FH message 

would be for the target if it was launched in simDriver configured for eramSimMode. 

 

 

Figure 82. FH Message Preview 

 

5.6.1.2. Target - Dynamics 

The Dynamics tab of the Target Editor defines the type of aircraft, its speed and altitude, and the path 
the target is flying in an airspace. A target's aircraft trajectory can be specified as a route with defined 
points, such as fixes and airports. 
 
When the first and/or last element on the route is an airport, GSGT can model appropriate departure or 
arrival from/to an airport, including modeling of particular runways on the airport. The runways must be 
predefined using Runways site definition in order to be available for inclusion. 
 
Based on the target's route definition, GSGT generates radar and derives appropriate messages such as 
flight plans and handoffs. 
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Figure 83. Target Editor Dynamics Tab 

 
Flight Plan 

AChar 

Drop-down menu allowing the user to select the aircraft characteristics of the target from the 

adapted aircraft types. 

Speed 

Whole numbers specifying the aircraft speed in knots followed by the characters ‘tas’ or ‘cas’ or 

Mach speed in decimal format either preceded or followed by ‘m’.  If only digits are entered, TAS 

speed is assumed.  The speed is not validated for the specified altitude or aircraft performance 

capabilities. 

Flevel 

Flight Level. 1-3 numeric characters designating the flight altitude in hundreds of feet. 
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Route 

Text defining the planned flight route of the target. Routes can be made up of airports, fixes, 

lat/lon points, airways, and more. 

Flight Dynamics 

Macro 

A text field where the user can change the path of a flight without changing its filed flight plan 

route. 

Populate Macro from FP Route 

Upon clicking this will populate the Macro text field with commands derived from the Route. If 

any changes are made to the macro, the target will fly as what is written in the macro, versus its 

filed flight plan. 

Show Flight Path 

Displays the target's route in the adaptation viewer with a target dynamics information box. 

Macro Help 

A help box that will give some macro format examples. 

 
The flight route can be entered in two ways, using the point and click feature of GSGT or by manually 
typing the flight route text in the dialog box. To use the point and click function, click the Route text box, 
then place the cursor over the desired element such as a fix or an airport and left-click the mouse. The 
element is added to the flight plan and displayed in the Route dialog box. As elements are added to the 
flight plan, fixes and airports are highlighted in BLUE, the flight route is outlined in RED between fixes, 
and segments along airways are outlined in GREEN. 
 
Point and click adds new elements to the end of the flight plan. To add or remove an element in the 
middle of the route, manually modify the fix text in the flight plan dialog box or place the cursor after 
the element (before "." or "..") that you want to insert additional elements. 
 
NOTE: GSGT does not allow delay times to be typed directly in the route text. In order to create a delay, 

create a new target Delay Event. 
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Figure 84. Show Flight Path 

 
Events 

List of events that are applied to the target.  The list specifies the condition when the event is applied 

and shortly describes the event.  Right mouse click context menu options: 

New 

Opens the Target Event Editor dialog for a new event. 

Edit 

Opens an existing target event in Target Event Editor dialog. 

Delete 

Deletes the currently selected target event(s). 
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Figure 85. Target Event Editor 

 
Target Events allow users to define a wide range of events that can be applied to a target to perform 
various tasks or change a target's characteristics. Reference table below describing all available events. 
 
Event Type List 

List of available event types that can be defined for the target. 

Trigger 

Allows user to set the time when the Target Event is performed as an offset of the target start time. 

Event 

The value(s) that will take effect when the Event is processed. The Drop Target Event does not have 

a Command value. 

Generate Msg 

If selected, a message reflecting the changed value will be generated. Only valid for ERAM scenarios 

and only for certain events such as change Acid, Altitude, Beacon, and Speed. 

RSI 

If selected, the RSI will be tied to the event for that Target. If that RSI is turned off the event will not 

trigger. 
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OK 

Closes the dialog and creates the specified Event. 

Cancel 

Closes the dialog and returns to the Target editor. 

 

Table 6.  Target Event Types 

Event Description 

Macro Add a custom macro to be injected.  

Change Beacon 
Changes target's beacon code with option to change Mode 3A, 
ADSB or both 

Change Ident Bit Sets ident bit to enabled or disabled 

Change Mode C Sets Mode C to enabled or disabled 

Change Run Length Changes target's run length to a specific value 

Change Track Eligibility Changes target's track eligibility to a specific value 

Change Search Target Quality Changes target's search target quality to a specific value 

Change Search Target 
Confidence 

Changes target's search target confidence to a specific value 

Change Time In Storage Changes target's time in storage to a specific value 

Change PSR Blip Scan 
Changes target's primary search return (PSR) to a specific 
percentage value. When using ATCoach engine, PSR Blip Scan will 
only apply if its value is set to either 0 or 100. 

Change SSR Blip Scan 
Changes target's secondary search return (SSR) to a specific 
percentage value. When using ATCoach engine, SSR Blip Scan will 
only apply if its value is set to either 0 or 100. 

Change Ghost Percentage 
Changes target's ghost percentage to a specific percentage value 
(HCS version only) 

Change Correlation Changes target's correlation 

Response Mode Override 
Overrides NAS responses such as DR or DX, or NAM responses such 
as LRM 

ADSB Reporting 
(Enable/Disable) 

Enables or Disabled ADSB transponder reporting 

ADSB Reporting Rate Sets ADSB target reporting rate 
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Custom macro commands can also be scripted as target events.  The table below lists the types of macro 
commands that are available. 
 

Table 7. Custom Macro Commands 

Command Description 

VNAV Commands 

->dddcas 
 

->dddcas~dddkt/min 
 

->dddtas 
 

->dddtas~dddkt/min 
 

->.ddm 
 

->.ddm~dddkt/min 
 

Change the calibrated air speed of the target to the value 
specified. 

Change the calibrated air speed of the target to the value 
specified at a given rate of change. 

Change the true air speed of the target to the value 
specified. 

Change the true air speed of the target to the value 
specified at a given rate of change. 

Change the mach speed of the target to the value specified. 
 

Change the mach speed of the target to the value specified 
at a given rate of change. 

->dddcas@dddddft or 
->dddtas@dddddft or 
->.ddm@dddddft 

->(+\-)dddcas 

Change the speed and altitude of the target to the values 
specified. 
 

Change the speed of the target by the specified amount. 

->dddddft 
 

->dddddft~dddd 
 

->(+\-)dddft 

Change the altitude of the target to the value specified in 
feet. 

Change the altitude of the target to the value specified in 
feet at a given rate of change (in feet per minute). 

Change the altitude of the target by the specified amount. 

LNAV Commands 

FIXNAME Proceed to the fix. 
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FIXNAME{attributes} 
 
 
 

Attributes: 

{arpt} 
 
 

{rw:dd} or {rw:ddA} 
 

{ils:dd} or {ils:ddA} 
 
 

{dddddft} 

{<dddddft} 

{>dddddft} 

{dddddftBdddddft} 
 

{dddcas}, {dddtas}, or {.ddm} 

{<dddcas}, {<dddtas}, or {<.ddm} 

{>dddcas}, {>dddtas}, or {>.ddm} 

{rf}{dddmag}{turnDir:A} 
 

Proceed to the fix and obey additional instructions or 
restrictions specified as attributes of the fix.  Some 
attributes (such as speed and altitude restrictions) may be 
combined for the same fix. 

 

On the first fix, auto-apply departure logic; on the last fix, 
auto-apply top of descent (TOD) restriction.  Not valid on 
other fixes. 

In conjunction with {arpt} on departures, use a defined 
departure procedure for the specified runway. 

In conjunction with {arpt} on arrivals, perform an ILS 
approach to the specified runway.  This disables TOD 
processing. 

Cross the fix at the specified restriction altitude. 

Cross the fix at or below the specified restriction altitude. 

Cross the fix at or above the specified restriction altitude. 

Cross the fix between the specified restriction altitudes.  
Order is of the restriction altitudes is irrelevant. 

Cross the fix at the specified restriction speed. 

Cross the fix at or below the specified restriction speed. 

Cross the fix at or above the specified restriction speed. 

Perform a radius to fix turn (in the specified turn direction), 
exiting the fix at the specified heading. 

->dddmag 
 

->dddmag~ddddeg/sec 
 

->dddtrue 
 

->dddtrue~ddddeg/sec 
 

->(+\-)ddddeg 

Change the heading of the target to the value specified in 
degrees from magnetic North. 

Change the heading of the target to the value specified in 
degrees from magnetic North at a given rate of change. 

Change the heading of the target to the value specified in 
degrees from true North. 

Change the heading of the target to the value specified in 
degrees from true North at a given rate of change. 

Change the heading of the target by the specified amount. 
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->hold 
 

->hold{legTime:dmin} 
 

->hold{turnDir:A} 
 

->hold{duration:dmin} 
 
 
 

->hold{count:d} 
 

Hold indefinitely with right hand turns and 1 minute leg 
lengths. 

Hold indefinitely with right hand turns and leg lengths as 
specified in minutes. 

Hold indefinitely with 1 minute leg lengths and left or right 
hand turns as specified. 

Hold with right hand turns and 1 minute leg lengths for the 
specified amount of time.  Once the duration time has 
expired, complete the current turn and proceed with the 
remaining route. 

Hold with right hand turns and 1 minute leg lengths for the 
specified number of laps. 

->drop Drop the target. 

Mode3A and Mode C Commands 

->Boooo Set or change the beacon code. 

->BE 

->BD 

Enable the Mode 3A beacon. 

Disable the Mode 3A beacon. 

->MCE 

->MCD 

Enable Mode C. 

Disable Mode C. 

->RADARE 

->RADARD 

Enable radar detection. 

Disable radar detection. 

->ADSBE 

->ADSBD 

Enable ADSB detection. 

Disable ADSB detection. 

Target Attributes 

->set:autoLogon=d 

->set:cpdlcResponseMode=<mode> 

Set the autoLogon attribute to 0, off, or 1, on. 

Set the cpdlcResponseMode attribute to manual or auto. 
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->set:cpdlcResponseDelay=ddd 
 

->set:script=name 

->set:tdls=name 

->set:disableTracker=d 
 

->set:freeText=text 

Set the cpdlcResponseDelay attribute to the specified 
number of seconds. 

Set the script attribute to the specified script name. 

Set the tdls attribute to the specified TDLS name. 

Set the disableTracker attribute to 1, disabled, or 0, 
enabled. 

Set the freeText attribute to the specified text. This appears 
in the datablock of the target. 

->clear:<attribute> Clear the target attribute specified. 

 
NOTE: A indicates an alphabetic character, d indicates decimal digits, o indicates octal digits, and ~ 

indicates a rate of change. 
 
 

5.6.1.3. Target - Messages 

The Messages tab of the Target Dialog lists all non-radar messages associated with the target. The 
messages can be auto-generated (auto-derived) based on the route of the target or manually created. 
Messages are defaulted to auto-generate but can be turned off when Auto-generate msgs is deselected. 
 
When target is set to auto-generate messages, GSGT will generate all appropriate non-radar messages 
such as flight plan, start tracking, and handoff control of the flight between controllers and/or facilities 
as needed. 
 
Additionally, parameters controlling the creation of auto-generated messages can be set in the scenario 
Preferences or Target Preferences. 
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Figure 86. Target Editor Messages Tab 

 

Table 8. Non-radar Message Color Coding 

Color Description 

GRAY auto-generated messages, cannot be edited unless frozen 

BLACK frozen messages 

 
NOTE: Frozen messages are always associated with the target and are not automatically updated as 

target characteristics are changed, except for when replicating and changing name and timing of 
the target. Auto-generated messages on the other hand, are automatically regenerated on every 
change to the target. 
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NOTE: Once a target enters a ‘live’ sector, derived messages are no longer generated. 
 
Auto-generate msgs 

Enables auto generation of messages for the target. 

Edit Prefs 

Set target specific preferences for auto-generated messages. 

Edit FP Overrides 

Sets override values for auto-generated FP messages. 

Edit FPL/CPL Overrides 

Sets override values for auto-generated FPL/CPL messages. 

Msgs 

List of non-radar messages associated with the target. Clicking on the 'Time' header will sort the 

messages in time order. Clicking on 'Device/Dest', 'Injector', or 'Text' will sort appropriate column in 

alphanumeric order. Clicking on any of these headers twice will reverse the order of the sort. 

 

Double click to edit a frozen message. 

 

Right mouse click context menu options: 

Delete 

Removes selected message(s) from the list. 

Replicate 

Opens the Replication dialog, which provides the ability to produce copies of the selected 

message(s) from the list. 

 

5.6.1.3.1. Auto Deriving Target Messages 

When the Auto-generate msgs box is checked, GSGT calculates target positions along its entire route 
and derives appropriate non-radar messages, and then populates the messages list. In order to 
accomplish this, GSGT runs the simulation engine. 
 
When the Auto-generate msgs box is unchecked while there are any derived messages in the list, a 
dialog box is displayed to confirm whether the derived messages should be saved as frozen messages or 
removed. 
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Figure 87. Freeze Derived Messages 

 

5.6.1.3.2. Edit Prefs 

Target Preferences override the scenario preferences on a per target basis. To enable override of any 
particular preference, select and check that preference. When a parameter is checked, its value will be 
applied to this target only. When unchecked, the general scenario Preference value will apply. 
 

 

Figure 88. Target Specific Preferences  
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Parameters in the Target Preferences behave exactly the same as in the scenario Preferences with an 
exception that target preferences are applied only per target basis.  See section 5.1.1 details each 
preference option. 
 
The section for deriving flight plans for domestic proposed flights is used to override the scenario 
preferences to force generation of FP or FPL. 
 
Use Default 

Uses default setting to generate FP or FPL according to scenario preference. 

Use FP 

Forces generation of FP regardless of scenario preference 

Use FPL with NADIN source 

Forces generation of FPL from specified NADIN device regardless of scenario preference. 

Additionally, in some situations AM messages are auto-derived from source device and with delta 

time as specified. 

 
When any of the parameters in the Target Preferences Editor are changed from the default, the ‘Edit 
Prefs’ button will show an attention icon indicating that values are changed, as illustrated below. 
 
 

 

Figure 89. Edit Prefs Attention Icon 

 
  



 
 
 

 
Volume 2: GSGT User Guide  March 8, 2024 
Version 13.4.19  Page 95 

5.6.1.3.3. FP Overrides 

The parameters in the FP Overrides Editor dialog override values in derived FP messages for this target 
only. When value is cleared, the default value in derived FP message is restored. 
 
 

 

Figure 90. Flight Plan Override Editor 

 
When any of the parameters in the FP Overrides Editor are set to be overwritten, the ‘Edit FP Overrides’ 
button will show an attention icon indicating that values are overridden, as illustrated below. 
 
 

 

Figure 91. Edit FP Overrides Attention Icon 
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5.6.1.3.4. FPL/CPL Overrides 

The parameters in the FPL/CPL Overrides Editor dialog override values in derived FPL/CPL messages for 
this target only. When value is cleared, the default value in derived FPL/CPL message is restored. 
 

 

Figure 92. ICAO Flight Plan Overrides Editor 

 
When any of the parameters in the FP Overrides Editor are set to be overwritten, the ‘Edit FPL/CPL 
Overrides’ button will show an attention icon indicating that values are overridden, as illustrated below. 
 

 

Figure 93. Attention Icon 
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5.6.1.3.5. Manually Creating Messages 

Creating non-radar messages for a target works identically as for System Commands with exception that 
messages are associated with the Target instead of being independent.  The same set of message editors 
is used to edit the messages, which are automatically determined for appropriate type of message. 
 
To create a new target message, select a message type and appropriate device(s) from the drop downs 
above the text input area.  Enter a message injection time offset and select an RSI, if desired.  Type the 
message contents into the free form text area and press enter or the ‘Save Message’ button.  The new 
message is added to the message list below the text input area.  Press ‘OK’ to update the target.  Some 
message types will only accept specific formats; for example rtcsmsg will only accept a message in xml 
format. 
 
Flight data messages scripted within the Target editor may include substitution tokens for target 
identification fields such as AID, CID, GUFI, etc.  Upon execution, these tokens will be replaced with the 
appropriate values for the target. 
 
Messages that are auto-derived cannot be edited until Auto-generate msgs is deselected. If the Auto-
generate msgs is selected after being deselected and the original generated messages were frozen, the 
messages will be automatically re-derived and in essence making a duplicate message. 
 
NOTE: Changes made in the Flight Plan Editor do NOT affect the target attributes set in the Target 

Attributes Editor. 
 

5.6.1.3.6. Validating Messages (RTCS & TTP) 

Manually created RTCS and TTP messages can be validated against the current schema.  After creating 
and saving the message, right click and select Validate <message type> 
 

 

Figure 94. RTCS and TTP Message Validation 
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A popup box will appear confirming the messages validation or detailing why the message failed 
validation. 

 

Figure 95. Validation Successful 

 

5.6.1.4. Target Dysim Definitions 

The Dysim tab of the Target editor provides ability to change engine specific options and define Pre-
Programmed Events and Pilot Prompts.  This tab is labeled Dysim when running with JVN simulation 
engine. 
 

 

Figure 96. Target Editor Dysim Tab  
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Independent Release 

Engine will not generate the target at the start time. It needs to be released from pilot position.  The 

flight will be in the scenario but no flight data messages will inject nor will the target start until the 

user manually injects them. 

Manual Release 

Engine will generate the target’s flight data messages but will not release the target at the start time. 

Pilot Position 

Pseudo Pilot assigned to the target (optional) (ERAM version only). 

 

5.6.2. Target List Context Menu 

Right-clicking on selected target(s) in the object tree of the Scenario Editor Main Window opens a 
context menu with certain actions such as Replicate and Filter by AID. 
 

 

Figure 97. Target List Context Menu 

 
New 

Display the Target Editor to create a new Target. 

Delete 

Delete the selected target(s). 
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Show Flight Path 

Display the target's route in the adaptation viewer with a target dynamics information box for 

selected Targets. 

Replicate 

Opens the Replication dialog, which provides the ability to produce copies of the selected target. 

Clear Replication(s) 

Clears all non-frozen replications, leaving only the original Target. 

Selection Count 

Displays how many Targets are currently selected. 

Assign RSI 

Assign the selected Targets the given RSI. 

Filter by AID 

Filters the Editor with only the selected Target(s). 

Deselect All 

Deselects each selected target. 

 

5.6.3. Target Conflict Message 

Any modification to the target's beacon code that results in a conflict is reported and must be confirmed 
by the user. 
 

 

Figure 98. Target Conflict Warning 
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Continue 

Saves the target with a duplicate beacon code. 

Cancel 

Closes the dialog and returns to the Target editor without applying the changes. 

 

5.7. Script Definitions 

Scenario developers can create sets of messages such as DataComm logon scripts or TTP flight updates. 
The DataComm logon scripts can be edited using the Script Definitions tab of the Scenario Editor.  
However, the XML formatted TTP messages must be manually edited with a text editor such as vi.  The 
script can be a set of common messages that can be applied to multiple targets without having to script 
each set individually for each target.  If a Target has a script defined it will run the script at the time set 
by the user.  The start of the script can be relative to the target start (activation) time or it can be 
triggered by a particular generated message. 
 

 

Figure 99. Script Definitions Tab  
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6. Preview 

The Preview function provides a dry-run simulation capability in GSGT, where users can visually examine 
targets defined in the scenario in a time based environment.  There are several types of preview 
functions in GSGT tailored for specific needs.  Preview, which simulates the entire scenario, and Show 
Flight Path, that allows to preview targets for fine tuning its parameters while in edit mode. 
 
When Preview is invoked, a dialog is presented to select options for the preview, such as the time to 
start the preview.  This is helpful particularly when scenario is several hours long but user wants to 
preview the last hour of the scenario.  Instead of running through the entire scenario from the start, 
preview can start at any specific time between the start and end of the scenario. 
 

 

Figure 100. Preview Options 

 
Start Time 

Select the time to start the Preview. 

Display Datablocks 

The selected targets in preview will have datablocks with their callsign, heading, speed and altitude. 

Display Independent Release Targets 

If selected the targets tagged for Independent Release will inject at their assigned starttime. 

OK 

Begins Preview Mode, starting at the specified Start Time. 

Cancel 

Cancels Preview Mode. 
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6.1. Scenario Preview 

Preview, also known as Scenario Preview, invokes a graphical display of all or just selected targets, 
activating at their appropriate time in the simulation. Preview also displays the messages associated with 
the targets at the point along the route corresponding to the time at which they would be injected. The 
target data blocks and displayed messages can be moved using left mouse click and drag to unclutter 
any particular feature on the display. 
 
To initiate a Preview, select Preview from the Scenario Editor and then click ‘OK’. 
 

 

Figure 101. Scenario Preview 

 
When Preview is invoked, the standard toolbar is replaced with a toolbar for controlling the preview.  
The controls include the ability to start, pause, and step through the preview.  Additionally, the preview 
can be run at a variable speed from 1 (real time) to 60 (1 minute of the sim = 1 second wall clock). 
 

 

Figure 102. Preview Controls 

 
Play 

Starts playing the preview at the specified run speed. 
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Pause 

Pauses the preview. 

Step 

Steps through the preview at time intervals of Speed value. 

Stop 

Stops the preview and returns to normal edit mode. 

Save 

Saves cloned targets. 

Speed 

Specifies the preview rate relative to the time in seconds. Valid range is 1-20 (1-60 in the HCS version) 

scenario seconds per real time second. 

Time 

The elapsed time of the preview - current scenario time. 

 
Targets can be highlighted using right mouse click on a target, which toggles the display of the macro 
route of the flight with each fix being a yellow dot and the yellow lines being the route the target will 
follow to its next fix. In addition, a context box is displayed with the target details such as its current 
position, speed, heading, and altitude. 
 

6.2. Show Flight Path 

The Show Flight Path function enables previewing targets while editing the scenario. Every target in this 
mode is previewed independently of other targets and can be moved back and forth along its preview. 
There are no controls to start or pause the preview. The preview is simply done by mouse dragging the 
airplane along its route. 
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Figure 103. Show Flight Path 

 
While a target is displayed in Show Flight Path preview, its flight plan route is displayed using yellow fixes 
connected by lines and dashes between segments along airways. Additionally, the target’s route of flight, 
which corresponds to surveillance positions, is displayed using plus symbols.  The target's actual route 
will reflect target events such as holds or heading changes.  Also, a context box is displayed with details 
such as current position, speed, heading and altitude which are updated as the target is dragged along 
the route.  This provides target details at a particular point in space and time.  When the dialog is closed 
or user right mouse clicks on the target, the target exits the Show Flight Path preview. 
 
To start a Show Flight Path preview for any set of targets, from the Scenario Editor window, select single 
target or group of targets using SHIFT or CTRL keys and left mouse click.  Then right click on the selected 
targets to open a context menu and select Show Flight Path. 
 
Optionally, all non-radar messages associated with the target can be previewed on its route, which are 
placed at position corresponding to the time when the messages are injected.  To preview messages 
associated with the target, select View button from the target context box and select Show Messages.  
Messages can be moved on the display using left mouse click and drag to unclutter any part of the 
display. 
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Figure 104. Target Flight Path 

 

6.3. Clone a Flight 

To clone a flight in GSGT, start preview mode from the Scenario Editor.  Make sure to have the flight that 
will be cloned already created in the scenario.  Then right click the flight on the map, and click 
ShowFlightPath.  This will enable the clone option for that flight to be selected. 
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Figure 105. Cloning a Flight in Preview 
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7. Import Functions 

GSGT includes functionality to import data from several different sources such as GSGT scenarios, 
directly from NASQuest,  from a comma separated values (CSV) file created from Command Message Set 
(CMS) data, or a STARS CDR file. 
 
Import must be performed in a currently open scenario. Before starting the Import process, users must 
create a new scenario or open an existing scenario. 
 

7.1. Import GSGT Scenario 

The GSGT Scenario import functionality enables the user to import an already existing GSGT scenario 
into the current scenario, in whole or in part. 
 
To start the import process, select Import->GSGT Sim from the GSGT Main Window. 
 

 

Figure 106. Import Scenario 

 
Select the GSGT scenario to import into current scenario. 
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Figure 107. Scenario Selection 

 
Back 

Disabled in this window. 

Finish 

Opens the selected scenario. 

Cancel 

Closes the window and cancels the import scenario action. 

 
After selecting a scenario, the following dialog is presented which allows the user to select the elements 
from the scenario to import. The first page allows the selection of preferences (Prefs), record select 
indicators (RSIs), Targets, System Commands, and Script Definitions. 
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Figure 108. Select Scenario Elements 

 
Back 

Returns to previous page of the import dialog. 

Next 

Advances to the next page of the import dialog. 

Cancel 

Closes the scenario import dialog. 

 
The second page allows the selection of user defined custom maps (if the selected scenario includes 
any). 
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Figure 109. Select Display Items 

 
Back 

Returns to previous page of the import dialog. 

Finish 

Imports the selected items into the current scenario. 

Cancel 

Closes the scenario import dialog. 

 
After import is complete, a message box is presented to review status of import and errors during parsing 
or opening of the selected scenario. 
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Figure 110. Import Errors and Warnings 

 

7.1.1. Import NASQuest Site 

To import data directly from the NASQuest server, start the process by selecting Import->Nasquest Site 
from the GSGT Main Window. 
 

 

Figure 111. NASQuest Site Import 

 

7.1.2. Import NASQuest CSV 

To import data from a NASQuest CSV file, start the process by selecting Import->Nasquest CSV from the 
GSGT Main Window. 
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Figure 112. Import CSV File 

 
Users have the option to filter the CSV file based on airports of interest. 
 

 

Figure 113. Import CSV Options 

 
The Finished CSV Import dialogue box will inform how many targets from the CSV file were imported.  
Click ‘OK’ when finished. 
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Figure 114. CSV Import Status 

 

7.1.3. Import STARS CDR 

The STARS CDR import function allows the user to import a CDR file that will generate Time Based Targets 
into the scenario. This function can be used to update older CDR radar data against today’s latest 
adaptation, including true north. 
 
Time Based Targets can be used in SimDriver for playback. In SimDriver, users can take control and 
dynamically pilot the targets. Please reference the Dysim Manual for more information. 
 
To start the import process, select Import->Stars CDR from the GSGT Main Window. 
 

 

Figure 115. STARS CDR Options 

 
Users have the option to Force Little Endian, Force Big Endian, or Extract IF Msgs. By default, GSGT will 
automatically detect the correct Endian type. 
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Select a CDR file that ends with the file type (*.cdr). 
 

 

Figure 116. Import CDR File 

 
 

 

Figure 117. CDR Import Status 

 
Time Based Targets are imported into the scenario. 
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Figure 118. Time Based Targets 

 
Time Based Targets are point based with latitude and longitude fixes. These fixes cannot be modified 
under the Dynamics tab; however, they can be dynamically controlled while using Dysim/simDriver. 

 
 

 

Figure 119. Time Based Targets - Dynamics 
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8. Export Functions 

GSGT provides two export functions, Export SDRR and Export GSGT, from the Scenario Editor window. 

8.1. Export SDRR 

The Export SDRR function converts the GSGT scenario into a static scenario for SDRR injection and 
playback.  The exported scenario includes surveillance data and non-surveillance messages.  Once the 
scenario is exported, it should be transferred to an SDRR processor for static scenario execution. 
 
 

 

Figure 120. Export SDRR 

 

8.2. Export GSGT 

The Export GSGT function is essentially the opposite of the Import GSGT function.  Export GSGT allows 
the user to create new GSGT scenarios from the currently opened scenario.  For example, the user can 
filter the current scenario and then export the filtered version to new scenario name. 
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Figure 121. Export GSGT 
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9. Reports and Tools 

GSGT includes the ability to generate various reports such as Traversal reports. All reports (as well as 
import and export logs) are written to files that can be viewed by any HTML browser outside of the GSGT 
application. 
 
After selection of the report and its options (if applicable), a dialog is displayed to choose a file name 
where the report will be saved.  If the file name already exists, a prompt will be displayed to confirm that 
the old file will be overwritten.  While the report is being created, a window is displayed indicating that 
the report is being generated.  Once the report is complete, a dialog is displayed asking to preview the 
report.  The report is always saved to a specified file, and it may be viewed at a later time by any HTML 
browser. 
 
The following reports are located on the main GSGT menu: GSGT Session Log, Simulated Target Position, 
FAV Traversal Report, and Simulated Radar Target Count. 
 
The rest of the reports are located in the scenario editor under reports: Sorted Scenario Listing and 
Message Injection Report. 
 

Table 9. List of Reports 

Report Name 

GSGT Session Log 

Sorted Scenario Listing 

Message Injection Report 

Simulated Target Position 

FAV Traversal Report 

Simulated Radar Target Count 
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Figure 122. Main Reports Menu 

 

 

Figure 123. Scenario Editor Reports Menu 

 

9.1. GSGT Session Log 

The Session Log displays messages that were generated during the current session while performing 
certain task.  Messages are logged for start and end of GSGT session, loading of a scenario, and import 
and export functions. 
 
To generate the report, select Reports->View/Save Session Log from the GSGT Main Window. 
 
The task that generated the message is shown in GRAY. Status and completion messages are shown in 
GREEN.  Warnings are shown in YELLOW and error messages are shown in RED. 
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Figure 124. GSGT Session Log 

 

9.2. Sorted Scenario Listing 

The Sorted Scenario Listing displays the injected messages for each target.  The targets can be sorted by 
name and RSI. 
 

 

Figure 125. Sorted Scenario List Options 

 
To generate the report, select Reports->Sorted Scenario Listing from the GSGT Main Window. 
 
Sort by RSI 

Group and sort the output by RSI. 

Sort Targets by Name 

Group and sort the output by the targets name. 
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OK 

Generates the report using the specified criteria. 

Cancel 

Closes the dialog and cancels the report. 

 

 

Figure 126. Sorted Scenario List Report 

 

9.3. Message Injection Report 

The Message Injection Report lists all scenario messages in chronological order based on injection time. 
 
To generate the report, select Reports->Message Injection Report from the GSGT Main Window. 
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Figure 127. Message Injection Report 

 
 

9.4. Simulated Target Position 

The GSGT Simulated Target Position report provides information on selected target positions at a 
specified time interval. 
 
NOTE: This is not available in Terminal/ERAMSim Mode. 
 
To generate the report, select Reports->Simulated Target Position from the GSGT Main Window. 
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Figure 128. Target Position Report Options 

 
Start Time 

Start time of the report. 

Length 

The length of time the report will cover. 

Interval 

The time interval of each target report. 

Targets 

The targets listed in the report. Hold down CTRL to select multiple targets. Clicking on Target ID or 

Starttime will sort the targets appropriately. 

OK 

Generates the report using the specified criteria. 

Cancel 

Closes the dialog and cancels the report. 

 
The first file displayed is a summary containing links to the report for each selected target.  Clicking on a 
link will display the individual target report. 
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Figure 129. Target Position Report File List 

 

 

Figure 130. Target Position Report 

 

9.5. FAV Traversal Report 

The FAV Traversal Report displays the FAV crossing times for the selected targets. 
 
To generate the report, select Reports->FAV Traversal Report from the GSGT Main Window. 
 
The dialog with report options is the same as in Simulated Target Position report. 
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The FAV Listing displays each aircraft ID and the time it enters each FAV. 
 

 

Figure 131. FAV Traversal Report 
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9.6. Simulated Radar Target Count 

The GSGT Simulated Radar Target Count. 
 

 

Figure 132. Target Count Report Options 

 
To generate the report, select Reports->Simulated Radar Target Count from the GSGT Main Window. 
 
Load 

The aircraft load to report. 

Interval 

The time interval used in the report. 

OK 

Generates the report using the specified criteria. 

Cancel 

Closes the dialog and cancels the report. 
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Figure 133. Target Count Report 
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10. Weather Editor 

The weather scenarios can be included in GSGT scenarios to provide more realistic simulation.  They are 
created using GSGT Weather Editor, which is a part of GSGT distribution.  The Weather Editor closely 
resembles the Scenario Editor; however, it is only designed to create and edit weather scenarios.  
Weather scenarios and regular scenarios are saved in different paths, so they may have exactly the same 
names.  However, it is recommended to use different names to be able to distinguish them easily. 
 

 

Figure 134. Weather Editor 

 
Since weather scenarios can be included into multiple GSGT scenarios they are included as read-only and 
can't be modified from within a regular scenario.  Also since they are shared, any change in the weather 
scenario will affect all scenarios that use that particular weather scenario. 
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10.1. Starting the Weather Editor 

The GSGT Weather Editor is executed using the executable wxEdit. 
 
To start the Weather Editor from the command line, enter: 
 

> wxEdit 

 
To launch a version of the Weather Editor that is not the default version, enter: 
 

> /usr/local/jvn.x.x.x/bin/wxEdit 

 
NOTE: Starting the Weather Editor from a command line while inside a weather scenario directory will 

automatically open that scenario. 
 

10.1.1. Command Line Options 

The Weather Editor can be started with options which control its operation. 
 

Table 10. Parameters for the Weather Editor 

Parameter Description 

--tbfmFormat TBFM mode for generating GRIB2 formatted weather. 

--native 

Default mode.  Same as no parameter.  Native mode provides the 
ability to export the scenario to SDRR for execution with the ERAM 
system. 

--proxy=server/port Opens wxEdit with specific server/port 

--version Display the Weather Editor version. 

--nofullscreen 
Not full screen mode; the Weather Editor will be stared in a window 
roughly half the size of the screen. 

--help Display application parameters. 
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For example, to start the Weather Editor in TBFM Mode, enter: 
 

> wxEdit --tbfmFormat 

 

10.1.2. Loading Adaptation 

The weather editor, by default, does not display any adaptation information because it's not adaptation 
specific, meaning it does not require an adaptation for creating or editing weather patterns.  However, 
it allows the user to load adaptation for a better visual reference but the adaptation is not saved with 
scenario. 
 
To load adaptation select Scenario->Load adaptation from the Weather Editor Main Window. 
 

 

Figure 135. Loading Adaptation 

 
The adaptation selection is performed in same manner as when selecting adaptation for regular scenario.  
Multiple adaptations can be selected to better aid creation of weather patterns.  Once the adaptation is 
loaded it may not be changed to a different adaptation during the same session.  To change adaptation, 
close the editor and restart to select a different adaptation. 
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Figure 136. Selecting an Adaptation 

 
NOTE: The weather scenario is defined on a national grid, in other words weather patterns are defined 

on a national scope.  A single weather scenario can be used by many site specific scenarios that 
in turn will use only a specific sub grid of the national weather. 
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Figure 137. Adaptation Display 
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10.2. Weather Editor GUI 

10.2.1. Weather Time Slice Windows 

Weather scenarios can consist of multiple time slices.  Time slices can only be defined during initial 
creation of a weather scenario.  The beginning time of the time slice is displayed in the title bar of the 
window or in the main title bar if the window is maximized. 
 
Every time slice in the weather scenario is contained in its own editor window.  Each of these windows 
can be separately adjusted to view maps and different types of weather.  Additionally, changing the 
stratum allows the user to view the different wind and temperature values for a particular level.  Stratum 
can be specified in pressure altitude (millibars or mb) or by flight level (FL).  Changing stratum does not 
affect the preview of pressure or precipitation.  Only wind and temperature may have different values 
at different stratum levels. 
 

Table 11. Weather Types 

Event Description 

Wind 
It's depicted by WHITE vectors indicating heading, and length indicating speed. Default 
speed and heading is 0 

Temperature  
It's depicted by gamma colors (blue being cold, red being hot) outlined every 10 
degrees. Default temperatures vary by stratum. For example default temperature at 
1000mb is 57.7 F and at 100mb it is -69.70 F. 

Pressure  
It's depicted by red and blue intensity colors, where red is high and blue is low 
pressure. The default pressure is 1013.25mb.  

Precip  
It's depicted by intensity in colors (blue, green, yellow, red, purple and white) ranging 
from light to most severe precipitation.  

 
 

10.2.2. Weather Editor Menus 

To preview weather, from the wxEdit window menu select View->Wx.  This opens a list of weather views 
(Wind, Temperature, Pressure, and Precip).  Select desired weather types to be viewed by repeating this 
step as necessary.  To remove wx data from the display select View->Wx and deselect the appropriate 
weather types. 
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Figure 138. Menu Bar 

 
View 

The pull-down menu is used to select weather data and map data for background display. The 

background functions may be displayed individually or in combination. 

Maps 

US Map (BLUE) 

Canada (BLUE) 

Mexico (BLUE) 

 

 

Figure 139. Map Selection 

 
Wx 

Temperature – Display the temperature. 

Pressure – Display the air pressure. 

Wind – Display the wind. 

Precip – Display the precipitation. 
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Figure 140. Weather Data Selections 

 
ARTCC 

 

 

Figure 141. ARTCC Options 
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Enter Pointer Mode 

Enter Pointer Mode – Default mode that enables selecting and editing weather values.  Disables 

adding weather. 

 

 

Figure 142. Enter Pointer Mode Menu Button 

 
Tool used for activities such as repositioning/centering map display, rubber band zoom, weather cell 
info. 

 

Moving map - Use left mouse button click and drag to move the map display 

Centering map - Use left mouse button click while holding Ctrl key. This will 
reposition display so that the point on the map where mouse click occurred will 
be positioned in the center of display. 

Rubber band zoom - Use left mouse button click and drag while holding Ctrl and 
Shift keys. This will draw a rectangular area representing the zoom detail after 
the mouse button is released. 

Weather cell info - Use right mouse click to display weather pattern information, 
such as temperature, pressure and winds in and particular point on the weather 
grid. The information is displayed in the status bar on the bottom of the display 
view. 

Adaptation info - If the adaptation is loaded in the view, use right mouse click 
within the FAV to display adaptation specific information such as FAV. This works 
in same fashion as in general GSGT Editor. 

 
 
Enter Selection Mode 

Enter Selection Mode – Enables modifying and adding weather. 

 

 

Figure 143. Enter Selection Mode Menu Button 

 
Pressure Alt Mode 

Pressure Altitude mode - Altitude in millibars of pressure.  Each pressure level corresponds directly 

to one of 37 RUC layers. (1000 mb is sea level, lower values indicate higher elevations) 
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Figure 144. Pressure Altitude Options 

 
Flight Level 

Altitude in hundreds of feet. 

 

 

Figure 145. Flight Level 

 
Zoom 

Provides a zoom function for the GSGT Adaptation Window. The zoom function is controlled three 

ways. The slide bar on the top right area of the window can be moved to set the zoom level. Clicking 

on the slide bar and then pressing the Page Down and Page Up keys will zoom the view in and out, 

respectively. The user may also use the scroll wheel on their mouse if applicable. 

 

 

Figure 146. Zoom 

 
Range 

Provides range of the current view in nm. The measurement of the range is taken horizontally across 

the middle of the viewer. 

 

 

Figure 147. Range 
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10.2.3. Weather Information 

Information for the existing RUC weather (Temperature, Pressure and Wind) is displayed in the status 
bar using a right mouse click on any specific point on the map.  The information for each cell includes 
temperature, pressure, and wind speed and direction. 
 

 

Figure 148. Weather Information Bar 

 

10.2.4. Viewer Configuration 

Weather scenarios are created with predetermined size of the viewer that covers continental US. To 
adjust zoom (Scale), location (Reference) and size (Width and Height) of the viewer select Scenario -> 
Edit Viewer Config from the Weather Editor Main Window. 
 
NOTE: The change is applied to all time slices and viewer is restarted. Make sure to save scenario changes 

before editing viewer configuration. 
 
Width 

Width of the working size of the viewer in nautical miles centered at Reference point. 

Height 

Height of the working size of the viewer in nautical miles centered at Reference point. 

Scale 

Scale determines the maximum zoom-out of the display viewer. Working size of the viewer 

(Width/Height) is not affected. Increasing the Scale, zooms-in and decreasing Scale zooms-out the 

maximum view. 

Reference 

Reference point is the center of display viewer. 
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10.3. Creating a New Weather Scenario 

A New Weather Scenario Wizard allows selection of scenario name and weather time slices to be defined 
in the new scenario. Newly created weather scenario includes standard temperature and pressure, zero 
wind and no precipitation. 
 
To create a new scenario, select Scenario->New from the Weather Editor Main Window. 
 
The wizard allows a back and forth navigation through pages of the wizard allowing the user to return to 
previous screen to modify any options before pressing Finish button. 
 
Back 

Goes to the previous screen. 

Next 

Goes to the next screen. 

Finish 

Completes scenario wizard and creates a new scenario according to selected options. 

Cancel 

Quits the scenario wizard without creating a new scenario. 
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10.3.1. Location and Name 

The selection of a name and location for new a weather scenario is identical as in the new GSGT scenario 
with the difference that weather scenarios are saved in a different location. The location of weather 
scenarios is controlled by $WX_PATH environment variable. 
 
 

 

Figure 149. Weather Scenario Name and Location 
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10.3.2. Weather Time Slices 

To add a time slice to a weather scenario, use the up/down arrows to select time slice hour, then click 
Add Time.  Weather scenario may include multiple time slices.  Add desired number of time slices for 
every hour before pressing Finish button.  Time slices cannot be easily added after weather scenario is 
created. 
 

 

Figure 150. WeatherTime Slices 

 
Hour 

List of hourly time slices to include in the scenario. 

Add Time 

Adds desired time slice (as selected in Hour field) at which weather should be injected into the 

scenario by setting time using up/down arrows. The only allowable time slices are in 1 hour 
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increments. Defined time slices are displayed in the list. To delete unwanted time slice, right click on 

that particular time in the list and select Delete. 

 

 

Figure 151. Deleting a Time Slice 

 
Repeat this as many times as needed to create all time slices at which the weather should be injected, 
selecting a single time slice or multiple time slices for injection. Rethink how long weather scenario 
needs to be and include a time slice for each hour. Once the weather scenario is created, the 
additional time slice is difficult to add as it requires a manual edit of the scenario files. 

 
  



 
 
 

 
Volume 2: GSGT User Guide  March 8, 2024 
Version 13.4.19  Page 144 

10.4. Open an Existing Weather Scenario 

Weather scenarios are opened in a similar matter as regular GSGT scenarios; however, wxEdit is used to 
open weather scenarios.  To open an existing scenario, select Scenario->Open from the wxEdit Main 
Window. 
 

 

Figure 152. Select Existing Weather Scenario 
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10.5. Edit weather scenario 

To edit weather attributes, preview the desired weather type from the View menu to aid selection and 
view changes. Also select desired Flight Level (or pressure altitude) from the menu bar, as temperature 
and wind may be different at different altitudes. 
 
To make changes to any of the weather patterns, select the weather attribute and click Enter Select 
Mode. Temperature, pressure and wind are modified using RUC editor, while precipitation is modified 
using Precipitation Editor. 
 

 

Figure 153. Enter Selection Mode 

 

10.5.1. RUC Editor 

To start editing RUC select one of the following weather attributes: Temperature, Pressure and Wind. 
The editor opens docked on the right side of the screen and may be repositioned on the screen if needed 
by grabbing its selection bar. To exit edit mode, use Close button on the editor dialog. 
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Figure 154. RUC Editor 

 
Layer 

The Strata layers that the new Temperature and Wind values will be applied to in hundreds of feet. 

 

Temperature and Wind have separate values for each RUC layer. The list displays 37 layers with 

corresponding range of altitudes. A single or multiple layers can be selected at once to apply a specific 

value. 

Weather Types 

The values for each of the weather types can be applied individually or in combination by enabling 

or disabling individual weather types. 

Add Weather 

While in Enter Selection Mode, hold the Shift or Ctrl button and use left mouse click and drag to 

draw a loop around the desired area to edit the weather values. Additional cells may be selected 

by holding Ctrl button and selecting additional area using left mouse click and drag or by right 
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mouse click on desired cell.  A right mouse click on a cell clears previous selection and selects a 

single cell.  Also a left mouse click clears current selection. 

 

 

Figure 155. Selecting Weather Cells 

 
One of the tools in RUC editor is ability to flood fill a contiguous area of the weather with the 
same value based on a single cell selection. To apply flood fill, select a single cell and fill in desired 
value for temperature or pressure, and press appropriate icon on the Tools toolbar, for ether 
temperature or pressure. To aid selection and preview, enable appropriate weather type in the 
view. 

 

10.5.1.1. Temperature 

Temperature values can be specified in several temperature scales, such as Fahrenheit, Celsius or Kelvin.  
The default is Fahrenheit, to specify Celsius append C or for Kelvin append K after temperature value.  
Also different temperature values can be specified at a different stratum layers. 
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Figure 156. Defining Temperature 

 

10.5.1.2. Pressure 

Pressure values are specified in millibars (mb) units of pressure. The "standard" sea level pressure is 
1013.25 mb. The range of pressure is 100 mb - 1100 mb. Only a single pressure value can be specified 
for all stratum levels. 
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Figure 157. Defining Pressure 

 

10.5.1.3. Wind 

Wind values can be specified in several ways, such as speed and heading, U and V components, or X and 
Y components depending on type of the input format selected. Also different wind values can be 
specified at a different stratum levels. 
 
The Speed and Heading input format defines wind speed in knots and heading in degrees. Depending on 
selected option Use X/Y coords, the wind values are aligned to true north (when turned on) or to RUC 
grid (when turned off). 
 
The Vector component input format defines wind using X/Y or U/V vectors in meters/sec. Depending on 
selected option Use X/Y coords, the wind values are aligned to true north (when turned on) or to RUC 
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grid (when turned off). The X/Y vectors are aligned to the true north, where X is E/W component and Y 
is N/S component. The U/V components are aligned to RUC grid, where U corresponds x axis of the grid 
plane and V corresponds the y axis of the grid plane. 
 
NOTE: When option Use X/Y coords is not set, the relative orientation of the axis does not correspond to 

true north orientation (North-South / East/West) due to the fact that RUC #236 grid is represented 
using lambert conformal projection with offset focal point. That is the projection focal point is not 
on an axis passing through the two geographic poles and grid plane axes do not follow constant 
latitude and longitude lines. 
 
When option Use X/Y coords is set, the orientation values are converted from True North to RUC 
grid orientation specific to location on the grid. RUC #236 grid data is always represented using 
lambert conformal projection regardless of input orientation. 

 

 

Figure 158. Defining Wind 
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Vector lines on the map represent wind direction and speed: longer lines representing higher wind 
speeds, shorter lines representing lower wind speeds. 
 
Wind affects precipitation areas, causing them to drift and morph much as real weather is affected by 
winds aloft. Precipitation is only affected when winds are defined at the 1000mb layer. Adding wind 
values to specific layers also affect aircraft performance for targets at a particular level causing them to 
slow down in a head wind and speed up with a tail wind. 
 

10.5.2. Precipitation Editor 

To start editing precipitation select the Precip weather attribute. The editor opens docked on the right 
side of the screen and may be repositioned on the screen if needed by grabbing its selection bar. To exit 
edit mode, use Close button on the editor dialog. 
 

 

Figure 159. Precipitation Editor 

 
Strata / Interval 

The Strata / Interval levels are in 5 increments (0-240, 240-600, 330-600, 600-0), that the new 

precipitation values can be applied to. 
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dbZ 

The value of intensity of precipitation.  A specific weather level value can be entered in the Value 

dialog or select Level and choose between Light, Moderate or Heavy. 

velocity 

The speed and direction of moving precipitation. The values can be input in several formats as well 

as relative to true north or precip grid. The orientation precip direction is based on the same 

projection as winds. The values applied here take precedence over RUC wind values for defining 

moving precipitation. 

 
While in Enter Selection Mode, hold the Shift button and use left mouse click and drag to draw a loop 
around the desired area to edit the weather values. Additional cells may be selected by holding Ctrl 
button and selecting additional area using left mouse click and drag or by right mouse click on desired 
cell. A right mouse click on a cell clears previous selection and selects a single cell. Also, a left mouse click 
clears current selection. 
 

10.5.2.1. Precipitation 

Precipitation value is specified in decibels (dbZ) units of precipitation and range from 0-99. This 
determines the intensity of the precipitation cell that was selected. The "default" precipitation in new 
scenario is 0 - no precipitation. Additionally, precipitation can be specified with a velocity using the same 
input format as Wind in RUC editor. 
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Figure 160. Defining Precipitation 

 
Precipitation level can also be specified by one of the preset levels Low, Moderate or High.  For additional 
reference below tables can be used to specify precipitation intensity for specific radar type. 
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Table 12. ASR Precipitation Levels 

Level Description 

9 – 29 level 1  

30 – 40 level 2  

41 - 45 level 3  

46 - 49 level 4 

50 - 56 level 5 

57 + level 6 

 
 

Table 13. ARSR Precipitation Levels 

Level Description 

10 – 29 Light precipitation  

30 – 49 Moderate precipitation  

50 +  Heavy precipitation  
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11. Source Scenario Files 

When a scenario is created, a directory is made with the name of the scenario in the location that is 
specified.  All aspects of the scenario are written to a set of files within the scenario directory. 

11.1. Scenario Components 

The scenario.xml file defines the components of the scenario.  All adaptation and customization that was 
selected when the scenario was created is listed in this file, including ERAM (eadp), STARS (dms), TBFM, 
and MEARTS.  The scenario.xml file lists each of the files that contain scenario targets, system commands, 
preferences, record select indicators, script definitions, active runways, restrictions, pilot controls, and 
device controls.  This file also lists the name of the weather scenario if one was selected when the 
scenario was created. 
 
NOTE: The MEARTS entry in the Facility portion of scenario.xml does not contain airspace but defines 

MEARTS radars. 
 

<scenario version="13.4.19"> 

  <airspace> 

    <eadp dir="ERAM/ZNY_f20e3no0"> 

      <override product="STAR.xml.75">./STAR.xml</override> 

      <tbfm dir="TBFM/ZNY_T4.8.3_2.0"/> 

    </eadp> 

  </airspace> 

  <facility> 

    <eadp dir="ERAM/ZNY_f20e3no0"> 

      <override product="STAR.xml.75">./STAR.xml</override> 

      <dms file="STARS/phl/phl_s6r8a01_y7_08a_Y708A.bl_j3011092022.rpt" name="PPP"/> 

      <mearts file="./mearts.txt" name="ppp"/> 

      <tbfm dir="TBFM/ZNY_T4.8.3_2.0"/> 

    </eadp> 

    <eadp dir="ERAM/ZBW_f20e3bo0"/> 

  </facility> 

  <targets>tgts.xml</targets> 

  <syscmds>syscmds.xml</syscmds> 

  <prefs>prefs.xml</prefs> 

  <rsi>rsi.xml</rsi> 

  <scriptDefinitions>scriptDefinitions.xml</scriptDefinitions> 

  <activeRunways>activeRunways.xml</activeRunways> 

  <restrictions>restrictions.xml</restrictions> 

  <pilotControls>pilotControls.xml</pilotControls> 
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  <devctl>devctl.xml</devctl> 

  <wx dir="./wx-weather-scenario"/> 

</scenario> 

 

11.2. Targets 

The tgts.xml file contains all of the targets that have been created or imported into the scenario.  It 
includes all of the attributes of each target, such as name, start time, aircraft type, equipage, route, 
dynamics, timed events, and any target specific messages that have been scripted or frozen. 
 
Example tgts.xml generated with a DMS Report File: 

<tgtlist> 

   <target autogen="1" bcn="3001" name="DEP01" time="00:04:00" 

transponderType="modes,1090es,cpdlc"> 

      <scriptAssignments/> 

      <dynamics achar="B737" flevel="100" speed="100tas"> 

         <route>KPHL..FJC</route> 

         <macro>KPHL{arpt} -&gt;100tas@10000ft FJC -&gt;drop</macro> 

      </dynamics> 

      <replication timeDelta="12000">3</replication> 

   </target> 

   <target autogen="1" bcn="4001" name="ARR01" time="00:00:00" 

transponderType="modes,1090es,cpdlc"> 

      <scriptAssignments/> 

      <dynamics achar="B737" flevel="100" speed="100tas"> 

         <route>QWEST..KPHL</route> 

         <macro>-&gt;86cas@10000ft QWEST KPHL{arpt} -&gt;drop</macro> 

      </dynamics> 

      <events> 

         <macro appendActiveCmd="1" delta="00:00:00">-

&gt;hold{turnDir:L}{duration:500sec}{legs:100sec}</macro> 

      </events> 

   </target> 

   <target autogen="1" bcn="1701" name="INJEC01" time="00:00:00" 

transponderType="modes,1090es,cpdlc"> 

      <scriptAssignments/> 

      <dynamics achar="B737" flevel="100" speed="100tas"> 

         <route>QWEST..KPHL</route> 

         <macro>-&gt;86cas@10000ft QWEST KPHL{arpt} -&gt;drop</macro> 

      </dynamics> 

      <msgList> 
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         <tcwMsg fac="PPP" position="*" time="00:00:00">[MULTI_FUNC]C[DELTA]ALL[ENTER] 

</tcwMsg> 

      </msgList> 

   </target> 

 
Example tgts.xml generated with a STARS Site File: 

<tgtlist> 

   <target autogen="0" bcn="0353" icaoAddress="0x111111" name="CA03" nasEquip="A" 

time="00:22:04" transponderType="modes"> 

      <dynamics achar="B737" flevel="080" speed="200tas"> 

         <route>ACY..PHL</route> 

         <macro>-&gt;200tas@8000ft +39:35:27.73,-074:17:41.88 PHL -&gt;drop</macro> 

      </dynamics> 

      <events> 

         <macro delta="00:00:00">-&gt;hold{turnDir:R}{legs:1}</macro> 

      </events> 

   </target> 

   <target autogen="0" bcn="0354" icaoAddress="0x111112" name="CA04" nasEquip="A" 

time="00:22:04" transponderType="modes"> 

      <dynamics achar="B737" flevel="080" speed="200tas"> 

         <route>ACY..PHL</route> 

         <macro>-&gt;200tas@8000ft +39:34:16.99,-074:13:36.38 +39:34:14.31,-074:13:26.67 -

&gt;drop</macro> 

      </dynamics> 

      <events> 

         <macro delta="00:00:00">-&gt;hold{turnDir:L}{legs:1}</macro> 

      </events> 

   </target> 

   <target autogen="0" bcn="0357" icaoAddress="0x111113" name="CA07" nasEquip="A" 

time="00:23:01" transponderType="modes"> 

      <dynamics achar="B737" flevel="080" speed="200tas"> 

         <route>ACY..PHL</route> 

         <macro>-&gt;200tas@8000ft +40:05:03.34,-075:02:53.22 -&gt;090 +40:05:03.44,-

075:02:53.22 -&gt;drop</macro> 

      </dynamics> 

      <events> 

         <macro delta="00:00:00">-&gt;hold{turnDir:R}{legs:1}</macro> 

         <ssrBlipScanChange delta="00:03:49" value="0"/> 

         <psrBlipScanChange delta="00:03:49" value="0"/> 

         <psrBlipScanChange delta="00:06:58" value="1"/> 

         <ssrBlipScanChange delta="00:06:58" value="1"/> 

      </events> 
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   </target>  

</tgtlist> 
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Example tgts.xml file with script assignments, timed events, and capability overrides: 

<tgtlist> 

   <target autogen="1" bcn="0145" isDCL="1" name="ABRR200" nasEquip="L" pilotPosition="500" 

rsi="500" tailNumber="ABR200" time="00:00:00" transponderType="modes,1090es,cpdlc"> 

      <scriptAssignments> 

         <script delta="-00:15:00">ABRR-2</script> 

      </scriptAssignments> 

      <dynamics achar="B738" flevel="430" speed="229tas"> 

         <route>KSFO./.4928/11305..YXE..5500N/09900W..5800N/09000W..DUGNO..TEFFO..KAGLY.. 

EMBOK..6400N/05000W..6400N/04000W..6300N/03000W..6200N/02000W..BALIX</route> 

      </dynamics> 

      <field918Overrides> 

         <DAT>1FANSE2PDC</DAT> 

         <EQP>SDE1E2E3FGHIJ2J3J4J5M1RXYZW</EQP> 

         <NAV>RNVA1D1E2</NAV> 

         <PBN>A1B1C1D1L1O1S2</PBN> 

      </field918Overrides> 

      <events> 

         <macro delta="00:00:00">-&gt;set:cpdlcResponseDelay=15</macro> 

      </events> 

      <replication icaoAddrDelta="0" targetIDDelta="0" timeDelta="24000">9</replication> 

   </target> 

   <target autogen="1" bcn="0355" isDCL="1" name="ABRR300" nasEquip="L" pilotPosition="500" 

rsi="500" tailNumber="ABR300" time="00:00:00" transponderType="modes,1090es,cpdlc"> 

      <scriptAssignments> 

         <script delta="-00:27:00">ABRR-3</script> 

      </scriptAssignments> 

      <dynamics achar="B738" flevel="430" speed="420tas"> 

         <route>KSLC./.3622/11410..LAKRR..ZZYZX..HAKMN..SHTNR..SMASH..SALYY..GLESN..ANJLL.. 

CAANN..BOYEL..CRCUS..KLAX</route> 

      </dynamics> 

      <field918Overrides> 

         <DAT>1FANSE2PDC</DAT> 

         <EQP>SDE1E2E3FGHIJ2J3J4J5M1RXYZW</EQP> 

         <NAV>RNVA1D1E2</NAV> 

         <PBN>A1B1C1D1L1O1S2</PBN> 

      </field918Overrides> 

      <events> 

         <macro delta="00:00:00">-&gt;set:cpdlcResponseDelay=15</macro> 

      </events> 

      <replication icaoAddrDelta="0" targetIDDelta="0" timeDelta="24000">9</replication> 

   </target> 
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11.3. System Commands 

The syscmds.xml file contains messages not related to a particular target.  Messages such as combine 
sector, switch activity, change parameter, map request, etc. can be scripted as general set-up messages. 
 

<syscmdlist> 

  <ssrvmsg device="E1" injectorName="zlc" rsi="100" sysSetup="1" time="00:00:00.00">CP DCST 

FACS/ON</ssrvmsg> 

  <ssrvmsg device="E1" injectorName="zlc" rsi="100" sysSetup="1" time="00:00:04.00">CP DCST 

IC/ON</ssrvmsg> 

  <ssrvmsg device="E1" injectorName="zlc" rsi="100" sysSetup="1" time="00:01:01.00">PF 02 

132.25</ssrvmsg> 

  <ssrvmsg device="R02" injectorName="zlc" rsi="100" sysSetup="1" time="00:01:04.00">MR 02 

ZLCMAP</ssrvmsg> 

  <ssrvmsg device="R10" injectorName="zlc" rsi="100" sysSetup="1" time="00:01:23.00">MR 10 

ZLCMAP</ssrvmsg> 

  <ssrvmsg device="R01" injectorName="zlc" rsi="100" sysSetup="1" time="00:01:24.00">MR 01 

ZLCMAP</ssrvmsg> 

</syscmdlist> 

 

11.4. Preferences 

The prefs.xml file lists global scenario preferences such as scenario run time, system setup time, and 
flight plan lead time. 
 

<Prefs> 

  <comments>Default prefs</comments> 

  <syssetuptime>00:02:00</syssetuptime> 

  <tgtintermsgtime>00:00:03</tgtintermsgtime> 

  <defaultFpLeadTime>00:15:00</defaultFpLeadTime> 

  <termFpLeadTime>00:02:00</termFpLeadTime> 

  <trackStartOffset>00:00:24</trackStartOffset> 

  <qnleadtime>00:00:20</qnleadtime> 

  <tileadtime>00:02:00</tileadtime> 

  <hoacceptdelta>00:00:30</hoacceptdelta> 

  <deriveFPLsSource>BGTLYWYX</deriveFPLsSource> 

  <allTargetsCpdlc>1</allTargetsCpdlc> 

  <externalFacRouteDistance>50</externalFacRouteDistance> 

</Prefs> 
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11.5. Record Select Indicators 

The rsi.xml file lists all of the record select indicators including the number and description of each RSI. 
 

<rsilist> 

  <rsi description="RADAR ONLY FLIGHTS">200</rsi> 

  <rsi description="ADSB ONLY FLIGHTS">300</rsi> 

  <rsi description="ZKC SYSCMDS">100</rsi> 

  <rsi description="Background Flights">500</rsi> 

  <rsi description="WMSCR MSGS">101</rsi> 

</rsilist> 

 

11.6. Script Definitions 

The scriptDefinitions.xml file is the place where scenario developers can create sets of messages such as 
DataComm logon scripts or TTP flight updates. The DataComm logon scripts can be edited using the 
Script Definitions tab of the Scenario Editor.  However, the XML formatted TTP messages must be 
manually edited with a text editor such as vi. 
 

<scripts> 

   <scriptDefinition name="ACID-mismatch"> 

      <triggerable processor="avionics" trigger="U163"> 

         <afnmsg delay="00:02:30.00" 

injectorName="avionics">FMHTEST01,@{paddedTailNo},@{address},%TS%/FPO@{arptSpos},1/FCOADS,0

1/FCOATC,01</afnmsg> 

      </triggerable> 

      <afnmsg injectorName="avionics" 

time="00:00:00.00">FMH@{aid},@{paddedTailNo},@{address},%TS%/FPO@{arptSpos},1/FCOADS,01/FCO

ATC,01</afnmsg> 

   </scriptDefinition> 

   <scriptDefinition name="ACID-mismatch_after_session"> 

      <afnmsg injectorName="avionics" 

time="00:00:00.00">FMH@{aid},@{paddedTailNo},@{address},%TS%/FPO@{arptSpos},1/FCOADS,01/FCO

ATC,01</afnmsg> 

      <afnmsg injectorName="avionics" 

time="00:15:30.00">FMHTEST02,@{paddedTailNo},@{address},%TS%/FPO@{arptSpos},1/FCOADS,01/FCO

ATC,01</afnmsg> 

   </scriptDefinition> 

</scripts> 
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11.7. Active Runways 

The activeRunways.xml file is where scenario developers can define the default runway for each airport 
that is listed. This file must be manually edited with a text editor such as vi. 
 

<activeRunways> 

  <activeRunway> 

    <airport name="KLAX"/> 

    <departureRunway name="RW24L"/> 

    <arrivalRunway name="06R"/> 

  </activeRunway> 

</activeRunways> 

 

11.8. Restrictions 

The restrictions.xml file is where restrictions can be defined for each fix and airport pair that is listed. 
This file must be manually edited with a text editor such as vi. 
 

<restrictions> 

  <restriction> 

    <key>ESSO</key> 

    <restriction>&lt;250cas@&lt;10000ft</restriction> 

    <arpt>KPHL</arpt> 

    <arpt>KPNE</arpt> 

    <arpt>KTTN</arpt> 

  </restriction> 

</restrictions> 
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11.9. Pilot Controls 

The pilotControls.xml file is where sector positions can be mapped to simulation pilot positions. When a 
handoff is accepted by a sector position controller in a dynamic simulation, the scenario target will be 
handed off to the simulation pilot mapped to that sector. This file must be manually edited with a text 
editor such as vi. 
 
 

<pilotControls> 

   <pilotControl controller="ZNY:PPP/1F" pilot="10" /> 

   <pilotControl controller="ZNY:PPP/1S" pilot="20" /> 

   <pilotControl controller="ZNY:PPP/1N" pilot="30" /> 

   <pilotControl controller="ZNY:PPP/1W" pilot="40" /> 

   <pilotControl controller="ZNY:PPP/1Y" pilot="50" /> 

</pilotControls> 

 

11.10. Device Control 

The devctl.xml file allows scenario developers to create events that modify the behavior of a simulated 
device. This file must be manually edited with a text editor such as vi. 
 
When running a scenario with a simulated Terminal Flight Data Manager (TFDM) interface, devctl lines 
can inject events for their TFDM Consumers. An example line would be as follows with the facility being 
the TFDM Consumer initiating the event and the time being relative to the scenario start time: 
 

<devctl devType="rtcs" facility="klax" time="00:01:30"> 

  <hbPeriod>7</hbPeriod> 

</devctl> 
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Table 14. Parameters for Simulated TFDM Device Control 

Parameter Description 

<hbPeriod/> The time (seconds) that the consumer injects heartbeat messages.  

<disableHBs/> 
The number of iterations that a heartbeat will not be sent. If a 
value < 0 or a value of ‘true’ is set, heartbeats will be disabled.  

<retransmitTimeout/> 
The time (seconds) that the consumer will wait before re-injecting 
an RTCS message, that requires a response. 

<maxRetries/> 
The number of times that a consumer will resend an RTCS message 
that requires a response. 

<delayReceiptAck/> 
The time (seconds) that the consumer will wait before sending a 
receipt acknowledgement message.  

<disableReceiptAck/> 
Boolean, if a value of ‘true’ is set consumer will not send receipt 
acknowledgement messages. 

<unsolicitedReconWaitTime/> 
The time (seconds) that the consumer will wait for a solicited recon 
from the producer before issuing a recon request.  

<reconRequest/> Sends a recon request message to the producer. 
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Appendix A. Acronyms 

 

AAR Adapted Arrival Routes 

AAV Aircraft Alert Volumes 

ACID Aircraft Identification 

ADAR Adapted Departure/Arrival Routes 

ADR Adapted Departure Routes 

ADS-B Automatic Dependent Surveillance – Broadcast 

AIG Application Interface Gateway 

AOI Area of Interest 

API Application Program Interface 

ARSR Air Route Surveillance Radar 

ARTCC Air Route Traffic Control Center 

ARTS Automated Radar Terminal System 

ASDI Aircraft Situation Display to Industry 

ASR Airport Surveillance Radar 

ASR-9 Airport Surveillance Radar Model-9 

ASTERIX All Purpose Structured Eurocontrol Radar Information Exchange 

ATC Air Traffic Control 

AViD Airspace Visualization Display 

BRTQC Beacon Real Time Quality Control 

CAS Commercially Available Software 

CD Common Digitizer 

CDR Continuous Data Recording 

CMS Common Message Set 

DASI Digital Altimeter Setting Indication System 

DASR Digital Airport Surveillance Radar 

DataComm Data Communications 
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DME Distance Measuring Equipment 

DP Departure Procedure 

DYSIM Dynamic Simulation 

ECG External Communications Gateway 

ECGP External Communications Gateway Protocol 

EDDS En Route Data Distribution System 

ERAM En Route Automation Modernization 

ETMS Enhanced Traffic Management System 

FAA Federal Aviation Administration 

FAV Fixed Airspace Volumes 

FDIO Flight Data Input/Output 

GIM-S Groundbased Interval Management-Spacing 

GSGT Graphic Simulation Generation Tool 

GUI Graphical User Interface 

IFDT Interfacility Flight Data Transfer 

JMS JAVA Messaging Service 

JRE Java Runtime Environment 

MIS Metering Information Service 

Mode 3/A Identification Reporting Mode of Secondary Radar 

Mode C Altitude Reporting Mode of Secondary Radar 

Mode S Mode Select Beacon System 

MLAT Multilateration 

NAS National Air Space 

NDB Non-directional (radio) Beacon 

NEMS NAS Enterprise Messaging System 

RAPPI Random Access Plan Position Indicator 

RF Radius-to-fix 

RSI Record Select Indicator 

RTCS Release Time Coordination Service 
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RTQC Real Time Quality Control 

SAA Special Activities Airspace 

SAC System Area Code 

SDRR Simulation Driver Radar Recorder 

SIC System Identity Code 

SIRS STARS Interfacility and Radar Simulator 

SMIF Simulation Interface Support 

SSRV Simulation Services 

STAR Standard Terminal Arrival Route 

STARS Standard Terminal Automation Replacement System 

SWIM System-Wide Information Management 

TACAN Tactical Air Navigation System 

TARP Time-based Archive Recording Player 

TAV Terrain Alert Volume 

TBFM Time Based Flow Management 

TFDM Terminal Flight Data Manager 

TFMS Traffic Flow Management System 

TRACON Terminal Radar Approach Control 

TSIM TBFM Simulation 

TTP TFDM Terminal Publication 

VOR Very High Frequency (VHF) Omni-Directional Range 

WAM Wide Area Multilateration 

WJHTC William J. Hughes Technical Center 

 


